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Type Conventions Used in This Document
Convention Meaning or Use

Bold Items in the user interface that you select or click. Text that you type
into the user interface.

<l[talic> Variables in commands, code syntax, and path names.

Ctri+L Press the two keys at the same time.

Courier Code examples. Messages, reports, and prompts from the software.
Omitted material in a line of code.

Omitted lines in code and report examples.

[ ] Optional items in syntax descriptions. In bus specifications, the
brackets are required.

() Grouped items in syntax descriptions.
{1} Repeatable items in syntax descriptions.

| A choice between items in syntax descriptions.
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= LATTICE Chapterl

Migrating Designs from
Diamond to CrossLink-NX on
the Radiant Software

When migrating ECP5 and CrossLink designs to CrossLink-NX on the
Radiant™ software, you should expect to go through the normal design
process, such as design entry, design analysis, debug, simulation, and
testing. While Diamond and the Radiant software are very similar, there are
substantial differences.

This chapter provides tips on how to rebuild your design using the Radiant IP,
PMI, primitives, and constraints.

IP and Modules |P are basic, configurable modules that provide a variety of
functions including 1/O, arithmetic, memory, and more. The Radiant IP
Catalog works similarly to the IP configuration in Diamond’s Clarity Designer.
IP Catalog offers a collection of IP that are similar to those found in Clarity
Designer.

In the Radiant software, signal names of the generated components have
been converted to lower case and “_i,” “ 0,” and “_io” suffixes added. Some
signals have been renamed. For example: DataA_Re to data_re_i and Cout to
overflow_o.
For differences in specific IP, see:

“Architecture IP” on page 9

“Arithmetic IP” on page 15

“DSP Arithmetic IP” on page 23

“Memory IP” on page 31

For more information on the IP, see the Radiant Help under References >
Lattice Module Reference Guide.

PMI PMI (Parameterized Module Instantiation) is an alternate way to use
some of the components that come with IP Catalog. Instead of using IP
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MIGRATING DESIGNS FROM DIAMOND TO CROSSLINK-NX ON THE RADIANT SOFTWARE

Catalog, PMI can directly instantiate a component into your HDL and
customize it by setting parameters in the HDL. The Radiant software has a
collection of PMI similar to Diamond’s. To help you with PMI, templates for
instantiating the modules are available in the Radiant Source Template view,
which is similar to the Diamond Template Editor. See “PMI” on page 40.

Primitives Lattice library primitives are very basic functions, such as logic
gates and flip-flops. Usually primitives are simply inferred in synthesis, but
they can be directly instantiated as HDL into designs. See “Primitives” on
page 46.

Preferences and Constraints Constraints are instructions applied to
design elements that guide the design toward desired results and
performance goals. The most common constraints are those for timing and
pin assignments, but constraints are also available for placement, routing, and
many other functions.

In Lattice Diamond, a Logical Preference File (.Ipf) is used to constrain a
design. In the Radiant software, preferences have been replaced by the
industry standard Synopsys Design Constraints for ease of use and improved
compatibility with third-party vendor tools such as Synopsys Synplify Pro.

This is one of the bigger differences between Diamond and Radiant designs.
See “Constraints” on page 53.
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MIGRATING DESIGNS FROM DIAMOND TO CROSSLINK-NX ON THE RADIANT SOFTWARE : Architecture IP

Architecture IP

The Radiant software has IP similar to all of Diamond’s architecture modules
except for dynamic bank controller.

PLL

In Diamond for ECP5 and CrossLink, a PLL IP is generated using Clarity
Designer. But in the Radiant software, IP Catalog is used to configure and
generate the PLL IP, which can then be instantiated into the RTL.

The PLL IP is located under the Architecture_Modules folder. The tool allows
you to provide an instance name, configure the PLL settings, and generate
the PLL module.

Once the configuration is completed, the PLL module can be generated by
clicking the Generate button. The generated module is inserted into the
project in the form of an .ipx file. From there, you can find all necessary
source, constraint, and configuration files generated from the tool. A right-
click on the .ipx file allows you to create and copy a Verilog instantiation
template or VHDL component declaration.

The following is the Verilog instantiation template from the generated PLL IP:
my PLL uw PLL{.clki i{ },
Lratn_if( ),

clkop ol ),
Jdock of )

DDR Generic

There is a new data_coarse_dly i signal.

Table 1: Feature Compatibility

Feature

Interface Type

Enable Tri-state Control
I/O Standard for this Interface

Bus Width for this interface

CrossLink in Diamond: ECP5 in Diamond: CrossLink-NX in Radiant

ddr_generic ddr_generic Software: DDR_Generic

Transmit, Receive Transmit, Receive, Transmit, Receive
Receive MIPI

Check box Check box Check box

Various Various Various

1-256 1-256 1-256
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Architecture IP

Table 1: Feature Compatibility (Continued)

Feature

Clock Frequency for this
Interface

Clock to Data Relationship at
the Pins

Gearing Ratio
Organize Parallel Data
Enable ECLK Bridge
Data Path Delay

Delay Value for User Defined

Coarse Delay Value for User
Defined

Enable Dynamic Margin
Control on Clock Delay

Generate PLL with this
Module

PLL Input Clock Frequency

PLL Reference Clock From
I/0 Pin

CLKI Input Buffer Type

Reference Clock From 1/O Pin

CrossLink in Diamond:
ddr_generic

Depends on Interface
Type, up to 600 MHz

Transmit: 4.685 — 600 MHz
Receive: 100 — 600 MHz

Edge-to-Edge, Centered

X1, X2
By Lane, By Time
N/A

Depends on Interface Type

Transmit: Bypass, Static
User Defined, Dynamic
User Defined

Receive: Bypass, Static
Default, Dynamic Default,
Static User Defined,
Dynamic User Defined

1-127

N/A

Check box

Check box

Various

Check box

Various

Check box

ECPS5 in Diamond:
ddr_generic

Depends on Interface
Type, up to 400 MHz

Transmit: 3.125 — 400 MHz
Receive: 100 — 400 MHz

Receive MIPI: 200 — 400
MHz

Depends on Interface Type

Transmit and Receive:
Edge-to-Edge, Centered

Receive MIPI: Centered
X1, X2

By Lane, By Time
Check box

Depends on Interface Type

Transmit: Bypass, Static
User Defined, Dynamic
User Defined

Receive: Bypass, Static
Default, Dynamic Default,
Static User Defined,
Dynamic User Defined

Receive MIPI: Static
Default, Static User
Defined

1-127

N/A

Check box

Check box

Various

Check box

Various

Check box

CrossLink-NX in Radiant
Software: DDR_Generic

Depends on Gearing
Ratio, up to 750 MHz

X1:100 — 250 MHz
X2:100 - 500 MHz
X4:100 - 750 MHz
X5:100 — 750 MHz

Edge-to-Edge, Centered

X1, X2, X4, X5
N/A
N/A

Depends on Interface Type

Transmit: Bypass, Static
User Defined, Dynamic
User Defined

Receive: Bypass, Static
Default, Dynamic Default,
Static User Defined,
Dynamic User Defined

0-126 (Fine Delay for User
Defined)

ONS, OP8NS, 1P6NS

Fixed, Dynamic (Clock
Path Delay)

Check box (Enable PLL
Instantiation)

10 — (Clock Frequency for
this interface) MHz

Check box

N/A
N/A
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Architecture IP

Table 1: Feature Compatibility (Continued)

Feature
ddr_generic

Reference Clock Input Buffer Various
Type

PLL Output Clock Tolerance  N/A

GDDR 7:1

Table 2: Feature Compatibility

Feature CrossLink in Diamond:
gddr_7:1

Interface Type Transmit, Receive

Bus Width 1-16

Interface Bandwidth 10 - 1200 Mbps

Clock Frequency (Pixel Clock) N/A

Enable Bit Alignment & Word Check box
Alignment Soft IP

Enable DELAYF Tuning
(Uses Dynamic Input Delay
block for adjusting Data and
Clock Delay)

Check box

Reference Clock from I/O Pin  Check box

Reference Clock Input Buffer  Various
Type

DDR MEM

Table 3: Feature Compatibility

Feature

Configuration (General) Tab

Interface
LPDDR3

1/O Buffer Configuration
Gearing Ratio N/A

DDR Memory Frequency

CrossLink in Diamond:

ECPS5 in Diamond:
ddr_generic

Various

N/A

ECP5 in Diamond:
gddr_7:1

Transmit, Receive
1-16

N/A

8-108 MHz
Check box

N/A

Check box

Various

ECP5 in Diamond: ddr_mem

DDR2, DDR3, DDRS3L, LPDDR?2,

Various, depending on Interface

Various, depending on Interface

CrossLink-NX in Radiant
Software: DDR_Generic

N/A

Percentage

CrossLink-NX in Radiant
Software: GDDR 7:1

Transmit, Receive
1-16

70-945 Mbps

N/A

Check box

Check box (Enable Data
Delay Control)

Check box

Various

CrossLink-NX in Radiant Software:
DDR_MEM

DDR3, DDR3L, LPDDR2, LPDDRS3

Various, depending on Interface

Various, depending on Interface
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Architecture IP

Table 3: Feature Compatibility (Continued)

Feature

DQS Buffer Configuration for DDR2
Number of DQ per DQS

Data Width

Data Mask
Clock/Address/Command

Enable Dynamic Margin Control on
Clock Delay

Generate PLL with this module

PLL Input Clock Frequency

PLL Reference Clock from 1/O Pin
CLKI Input Buffer Type
Clock/Address/Command Tab
Number of Clocks

Address Width

Bank Address Width

Number of Chip Selects

Advanced Settings

DQS Read Delay Adjustment Enable
DQS Read Delay Adjustment

DQS Read Delay Value

DQS Write Delay Adjustment Enable
DQS Write Delay Adjustment

DQS Write Delay Value

ECP5 in Diamond: ddr_mem

Single-ended, Differential

4,8

Various, depending on Interface
Check box

Check box

Check box

Check box
Various
Check box

Various

1,2,4
13-16
2,3

1,2,4

N/A

FACTORYONLY, PLUS, MINUS
PLUS: 1-255; MINUS: 1-256
N/A

FACTORYONLY, PLUS, MINUS
PLUS: 1-255; MINUS: 1-256

MIPI_DPHY
Modified for CrossLink-NX:

Differential data paths has been combined to a bus.

CrossLink-NX in Radiant Software:
DDR_MEM

N/A

4,8

Various, depending on Interface
Check box

Check box

Check box

N/A
N/A
N/A
N/A

1,2,4
13-16
3

1,2,4

Check box

POSITIVE, COMPLEMENT
0-255

Check box

POSITIVE, COMPLEMENT
0-255

Improved performance for the Hard MIPI implementation.

Added for CrossLink-NX:
Hard CIL for MIPI DPHY protocol

Support for HS reverse transmission
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Architecture IP

Table 4: Feature Compatibility

Feature

Interface Type
MIPI Interface Application
DPHY Module Type

MIXED DPHY Mode

DPHY PLL Mode
DPHY Clock Mode
Interface Data Rate
Gearing Ratio

Bus Width

DPHY PLL Input Reference
Frequency

Reference Clock from /O pin
Reference Clock Input Buffer Type

Interface Clock Frequency

Added LMMI and CIL ports

Support for Soft MIPI_DPHY Transmitter
Internal dedicated PLL for Hard MIPI DPHY

CrossLink in Diamond: mipi_dphy

Receive, Transmit
CSl-2, DSI

Hard MIPI DPHY (Tx/Rx),
Soft MIPI DPHY (Rx only)

N/A

N/A

N/A

20-1500 Mbps
8:1, 16:1

1-4

24-200 MHz

“supported”
“supported” — LVDS default
10-750 MHz

CrossLink-NX in Radiant Software:
MIPI_DPHY

Receive, Transmit
CSl-2, DS

Hard MIPI DPHY (Tx/Rx),
Soft MIPI DPHY (Tx/Rx)

CIL, No CIL (Crosslink Equivalent is
No CIL)

Internal, External
Continuous, Non-Continuous
80-2500 Mbps

8,16

1-4

24-200 MHz

“supported”
“supported” — MIPI DPHY default
40-1250 MHz

SDR

CrossLink-NX has a new coarse_dly_i signal.

Table 5: Feature Compatibility

Feature

Interface Type

Enable Tri-state Control

I/O Standard for this Interface
Bus Width for this interface

Clock Frequency for this Interface

Clock Inversion

CrossLink and ECP5 in Diamond:
sdr

Transmit, Receive
Check box
Various

1-256

1-200 MHz
Check box

CrossLink-NX in Radiant Software:
SDR

Transmit, Receive
Check box
Various

1-256

1-300 MHz

Check box (Enable Clock Inversion)
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MIGRATING DESIGNS FROM DIAMOND TO CROSSLINK-NX ON THE RADIANT SOFTWARE : Architecture IP

Table 5: Feature Compatibility (Continued)

Feature CrossLink and ECPS5 in Diamond: CrossLink-NX in Radiant Software:
sdr SDR

Data Path Delay Depends on Interface Type Depends on Interface Type
Transmit: Bypass, Static User Defined, Transmit: Bypass, Static User Defined,
Dynamic User Defined Dynamic User Defined
Receive: Bypass, Static Default, Receive: Bypass, Static Default,
Dynamic Default, Static User Defined, Dynamic Default, Static User Defined,
Dynamic User Defined Dynamic User Defined

Delay Value for User Defined 1-127 0-126 (Fine Delay)

Coarse Delay Value for User Defined  N/A ONS, OP8NS, 1P6NS
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Arithmetic IP

ArithmeticlP

The Radiant software has IP similar to all of Diamond’s arithmetic modules
except for fft_butterfly. The arithmetic IP of Diamond and the Radiant software
are very similar except for a couple of differences:

Data input widths often have a larger range. In Diamond, input widths are
sometimes no more than 32 bits. In Radiant, input widths can be up to 64

bits.

The Bus Ordering Style (Big Endian or Little Endian) option is not

available in the Radiant software.

Adder

Table 6: Feature Compatibility

Feature

Specify the Data Width of the Adder

Specify the Representation of the
Adder

Complex Inputs

Use Carry-in port

Specify the Carry-out Port

Enable Output Register

Specify number of pipeline stages

Bus Ordering Style

CrossLink and ECP5 in Diamond:

adder
1-64

Signed, Unsigned

Check box

Check box

None, Carry-Out

Check box

Depends on Data Width

Big Endian, Little Endian, None

CrossLink-NX in Radiant Software:

Adder

2-64 (Input Width)

Signed, Unsigned (Input Signed)
Check box (Complex Number
Addition)

Check box (Carry-In Addition)
None, Overflow (Carry-Out Addition)
Check box (Registered Outputs)
Depends on Input Width (Pipelines)
N/A

Adder Subtractor

Table 7: Feature Compatibility

Feature

Specify the Data Width of the
Adder_Subtractor

Specify the Representation of the
Adder_Subtractor

Complex Inputs

Use Carry-in port

CrossLink and ECP5 in Diamond:

adder_subtractor

1-64

Signed, Unsigned

Check box
Check box

CrossLink-NX in Radiant Software:

Adder_Subtractor

2-64 (Data Width)

Signed, Unsigned (Input Signed)

Check box (Inputs)
Check box (Carry-In)
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Arithmetic IP

Table 7: Feature Compatibility (Continued)

Feature

Specify the Carry-out Port
Enable Output Register
Specify number of pipeline stages

Bus Ordering Style

CrossLink and ECP5 in Diamond:

adder_subtractor
None, Carry-Out
Check box

Depends on Data Width

Big Endian, Little Endian, None

CrossLink-NX in Radiant Software:
Adder_Subtractor

None, Overflow (Carry-Out)
Check box (Enable Output Register)
Depends on Input Width (Pipelines)

N/A

Comparator

Table 8: Feature Compatibility

Feature

Specify the data width of the
comparator

Specify the representation of
comparator

Specify the output port compare
function

Use LUT based implementation (to
use lesser resources)

Enable Output Register
Specify number of pipeline stages

Bus Ordering Style

CrossLink and ECP5 in Diamond:

comparator

1-64

Signed, Unsigned

Various

Check box

Check box
Depends on data width

Big Endian, Little Endian, None

CrossLink-NX in Radiant Software:
Comparator

2-64 (Data Width)

Signed, Unsigned (Input Signed)
Various (Compare Function)

N/A

Check box (Enable Output Register)
Depends on Data Width (Pipelines)
N/A

Complex Multiplier

Table 9: Feature Compatibility

ECP5 in Diamond:
complex_multiplier

CrossLink-NX in Radiant
Software: Complex_Mult

Feature CrossLink in Diamond:
complex_multiplier

Block Implementation LUT

Input A Width 2-36

Input B Width 2-36

Representation Signed, Unsigned

LUT, DSP

2-36
2-36

Signed, Unsigned

LUT, DSP
(Implementation)

2-64 (Input A Width)
2-64 (Input B Width)

Signed, Unsigned (Input
Signed)
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Arithmetic IP

Table 9: Feature Compatibility (Continued)

Feature

Specify the Number of
Pipeline Stages
Enable Input Registers

Enable Output Registers

Implementation

Bus Ordering Style

CrossLink in Diamond:
complex_multiplier
Depends on Input Width
Check box

Check box

3 Multiplier, 4 Multiplier
Big Endian, Little Endian,

ECPS5 in Diamond:
complex_multiplier

Depends on Input Width
and Block Implementation

Depends on

CrossLink-NX in Radiant
Software: Complex_Mult

Implementation (Pipelines)

Check box Check box (Registered
Inputs)

Check box Check box (Registered
Outputs)

3 Multiplier, 4 Multiplier N/A
Big Endian, Little Endian,  N/A

None

None

Convert

Table 10: Feature Compatibility

Feature CrossLink and ECP5 in Diamond: CrossLink-NX in Radiant Software:
convert Convert

Input Width 1-256 1-256

Input Binary Point 0-7 0-7

Input Sign Signed, Unsigned SIGNED, UNSIGNED

Output Width 1-256 1-256

Output Binary Point 0-7 0-7

Output Sign Signed, Unsigned N/A

Rounding Truncate, Nearest, Convergent Truncate, Nearest, Convergent

Saturate Wrap, Min_Max Wrap, Min_Max
Counter

Table 11: Feature Compatibility

Feature

Specify the data width of the counter

Specify the direction of the counter

Optimized for speed

CrossLink and ECP5 in Diamond:

counter
1-64

Up, Down, Up-Down

Check box

CrossLink-NX in Radiant Software:
Counter

1-64 (Data Width)

Up, Down, UpDown (Counter
Direction)

N/A
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Arithmetic IP

Table 11: Feature Compatibility (Continued)

Feature

Lower count value
Upper count value
Enable load input

Bus Ordering Style

CrossLink and ECP5 in Diamond:
counter

Depends on data width
Depends on data width
Check box

Big Endian, Little Endian, None

CrossLink-NX in Radiant Software:
Counter

Depends on Data Width
Depends on Data Width
Check box

N/A

LFSR

Table 12: Feature Compatibility

Feature

LFSR Type

Gate Type

Number of Bits

Feedback Polynomial

Initial Value

Enable Parallel Output

Use Reloadable Seed Values

Bus Ordering Style

CrossLink and ECP5 in Diamond:
Ifsr

Fibonacci, Galois
XOR, XNOR
1-512

Various

Various

Check box
Check box

Big Endian, Little Endian, None

CrossLink-NX in Radiant Software:
LFSR

Fibonacci, Galois
XOR, XNOR
1-512

Various

Various

Check box
Check box

N/A

Multiply Accumulate

Table 13: Feature Compatibility

Feature CrossLink in Diamond: ECP5 in Diamond:
multiply_accumulate multiply_accumulate

Block LUT LUT, DSP

Implementation

Add/Sub Operation  Add, Sub Add, Sub

Input A Width 2-36 2-36

Representation Signed, Unsigned Signed, Unsigned

Input B Width 2-36 2-36

Representation Signed, Unsigned Signed, Unsigned

CrossLink-NX in Radiant
Software: Mult_Accumulate

LUT, DSP (Implementation)

Addition, Subtraction
(Addition/Subtraction)

2-64
Signed, Unsigned
2-64

Signed, Unsigned

Lattice Radiant Software Guide for Lattice Diamond Users

18



MIGRATING DESIGNS FROM DIAMOND TO CROSSLINK-NX ON THE RADIANT SOFTWARE

Arithmetic IP

Table 13: Feature Compatibility (Continued)

Feature

Accumulator Width

Specify the Number
of Pipeline Stages

Enable Input
Registers

Enable Output
Registers

Bus Ordering Style

CrossLink in Diamond:
multiply_accumulate

1-32

Depends on Input Width

Check box

Check box

Big Endian, Little Endian,
None

ECPS5 in Diamond:
multiply_accumulate

1-32

Depends on Input Width and
Block Implementation

Check box

Check box

Big Endian, Little Endian,
None

CrossLink-NX in Radiant
Software: Mult_Accumulate

Depends on Input Width

Depends on Implementation
(Pipelines)

Check box (Registered
Inputs)

Check box (Registered
Outputs)

N/A

Multiply Add Subtract

Table 14: Feature Compatibility

Feature

Block Implementation

Add/Sub Operation

Input AO/A1 Width

Representation

Input BO/B1 Width

Representation
Specify the Number of
Pipeline Stages
Enable Input Registers

Enable Output Registers

Bus Ordering Style

CrossLink in Diamond:
mult_add_sub

LUT

Add, Sub

2-36

Signed, Unsigned

2-36

Signed, Unsigned

Depends on Input Width

Check box

Check box

Big Endian, Little Endian,
None

ECP5 in Diamond:
mult_add_sub

LUT, DSP

Add, Sub

2-36

Signed, Unsigned

2-36

Signed, Unsigned
Depends on Input Width
and Block Implementation
Check box

Check box

Big Endian, Little Endian,
None

CrossLink-NX in Radiant
Software: Mult_Add_Sub

LUT, DSP
(Implementation)

Addition, Subtraction
(Addition/Subtraction)

2-64 (Input A Width)

Check box (Input A
Signed)

2-64 (Input B Width)

Check box (Input B
Signed)

Depends on
Implementation (Pipelines)

Check box (Registered
Inputs)

Check box (Registered
Outputs)

N/A
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Arithmetic IP

Multiply Add Subtract Sum

Table 15: Feature Compatibility

Feature

Block Implementation

Add/Sub 0 Operation
Add/Sub 1 Operation
Input AO/A1/A2/A3 Width
Representation

Input B0/B1/B2/B3 Width
Representation

Specify the Number of
Pipeline Stages

Enable Input Registers

Enable Output Registers

Bus Ordering Style

CrossLink in Diamond:
mult_add_sub_sum

LUT

Add, Sub

Add, Sub

2-36

Signed, Unsigned

2-36

Signed, Unsigned
Depends on Input Width

Check box

Check box

Big Endian, Little Endian,
None

ECP5 in Diamond:
mult_add_sub_sum

LUT, DSP

Add, Sub

Add, Sub

2-36

Signed, Unsigned
2-36

Signed, Unsigned

Depends on Input Width
and Block Implementation

Check box

Check box

Big Endian, Little Endian,
None

CrossLink-NX in Radiant
Software:
Mult_Add_Sub_Sum

LUT, DSP
(Implementation)

Add, Sub

Add, Sub

2-64

Signed, Unsigned
2-64

Signed, Unsigned

Depends on Input Width
(Pipelines)

Check box (Registered
Inputs)

Check box (Registered
Outputs)

N/A

Multiplier

Table 16: Feature Compatibility

Feature

Use a Constant Coefficient

Constant Coefficient Value
Use RAM Based Multiplier

Block Implementation

Input A Width

Representation

Input B Width

CrossLink in Diamond:
multiplier

Check box

(-2731) to (2731-1)
Check box
LUT

2-36

Signed, Unsigned

2-36

ECP5 in Diamond:
multiplier

Check box

(-2731) to (2731-1)
Check box
LUT, DSP

2-36

Signed, Unsigned

2-36

CrossLink-NX in Radiant
Software: Multiplier

Check box (Use
Multiplication Co-efficient)

(-2%31) to (2/31-1)
N/A

LUT, DSP
(Implementation)

2-64

Signed, Unsigned (Input A
Signed)

2-64
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Table 16: Feature Compatibility (Continued)

Feature
Representation
Specify the Number of
Pipeline Stages
Enable Input Registers

Enable Output Registers

Bus Ordering Style
None

CrossLink in Diamond:
multiplier

Signed, Unsigned
Depends on Input Width
Check box

Check box

Big Endian, Little Endian,

multiplier

Check box

Check box

None

ECP5 in Diamond:

Signed, Unsigned

Depends on Input Width
and Block Implementation

Big Endian, Little Endian,

CrossLink-NX in Radiant
Software: Multiplier

Signed, Unsigned (Input B
Signed)

Depends on Block
Implementation (Pipelines)

Check box (Registered
Inputs)

Check box (Registered
Outputs)

N/A

Sin-Cos Table

Table 17: Feature Compatibility

Feature

Block Implementation

Input Theta Bit Width

Output Result Bit Width

Output Mode

Use Tables for Quarter-wave only
Use 1-bit for Signed Integer

Enable Input Registers

Enable Output Registers

Specify the number of pipeline stages

Bus Ordering Style

CrossLink and ECP5 in Diamond:

sin-cos_table
LUT, EBR

3-10

4-32

Sin, Cos, Sin-Cos
Check box

Check box

Check box

Check box

1-3

Big Endian, Little Endian, None

CrossLink-NX in Radiant Software:
Sin_Cos_Table

LUT, EBR

3-10

4-32

Sin, Cos, Sin-Cos
Check box

Check box

Check box
Check box

1-3

N/A

Subtract
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Arithmetic IP

Table 18: Feature Compatibility

Feature

Specify the Data Width of the
Subtractor

Specify the Representation of the
Subtractor

Complex Inputs

Use Carry-in port

Specify the Carry-out Port

Enable Output Register
Specify number of pipeline stages

Bus Ordering Style

CrossLink and ECP5 in Diamond:
subtractor

1-64

Signed, Unsigned

Check box

Check box

None, Carry-Out

Check box
Depends on Data Width
Big Endian, Little Endian, None

CrossLink-NX in Radiant Software:
Subtractor

2-64 (Input Width)

Signed, Unsigned (Input Signed)

Check box (Complex Number
Subtraction)

Check box (Carry-In Subtraction)

None, Overflow (Carry-Out
Subtraction)

Check box (Registered Outputs)
Depends on Input Width (Pipelines)
N/A
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DSP ArithmeticlP

For ECP5, Diamond provides several IP that implement arithmetic functions
using DSP blocks. For CrossLink-NX, the Radiant software has some that are
similar to the IP for ECP5 in Diamond but with fewer options to make
configuration simpler. To see the differences, use the following tables. The
DSP arithmetic IP for CrossLink-NX are:

DSP_Mult_Accumulate
DSP_Mult_Add_Sub
DSP_Mult_ Add_Sub_Sum
DSP_Multiplier

DSP Multiply Accumulate

Table 19: Feature Compatibility

Feature

Input A Width

Input B Width

Data Type A

Data Type B

Source A

Source B

Select Shift Out A
Select Shift Out B
Add/Sub Operation
Input Register A
Input A Clock
Input A Clock Enable
Input A Reset

Input Register B
Input B Clock

Input B Clock Enable
Input B Reset
Pipeline Mode

Pipeline Register

CrossLink-NX in Radiant Software:
DSP_Mult_Accumulate

ECP5 in Diamond: mac

2-72 2-72
2-72 2-72
Signed, Unsigned, Dynamic Signed, Unsigned

Signed, Unsigned, Dynamic Signed, Unsigned

Parallel, Shift, Dynamic N/A
Parallel, Shift, Dynamic N/A
Check box N/A
Check box N/A

Add, Sub, Dynamic N/A 4
Check box Check box
CLKO, CLK1 N/A

CEO, CE1, CE2, CE3 N/A 2
RSTO, RST1 N/A 3
Check box Check box
CLKO, CLK1 N/A '

CEO, CE1, CE2, CE3 N/A 2
RSTO, RST1 N/A 3
Check box N/A
Check box Check box
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Table 19: Feature Compatibility (Continued)

Feature ECP5 in Diamond: mac CrossLink-NX in Radiant Software:
DSP_Mult_Accumulate

Output Register Check box Check box
Bus Ordering Style Big Endian, Little Endian, None N/A

1 Two clocks were used in ECPS5. However, CrossLink-NX DSP primitives only use a
single clock for input and output.

2 ECP5 has four selectable clock enables (CEO, CE1, CE2, and CE3). In CrossLink-
NX DSPs, the clock enables are already designated (ce_a_i for input A, ce_b_i for
input B, ce_p_i for pipeline, and ce_o_i for output).

3 Two resets are used in ECP5. However CrossLink-NX uses designated resets for
input and output (rst_a_i for input A, rst_b_i for input B, rst_p_i for pipeline, and rst_o
_ifor output).

4 The Add/Sub operation in the Radiant software is always dynamic.

Table 20: Port Compatibility

ECP5 in Diamond: mac CrossLink-NX in Radiant Software:
DSP_Mult_Accumulate

CLKO N/A
CLK1 N/A
N/A clk_i
CEO N/A
CE1 N/A
CE2 N/A
CE3 N/A
N/A ce_a_i
N/A ce b i
N/A ce_o_i
RSTO N/A
RST1 N/A
N/A rst_a_i
N/A rst_b_i
N/A rst_o_i
SignA N/A
SignB N/A
SourceA N/A
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Table 20: Port Compatibility (Continued)

ECP5 in Diamond: mac

SourceB
ACCUMSLOAD
ADDNSUB
A

B

LD

SRIA

SRIB
ACCUM
SROA
SROB
OVERFLOW

CrossLink-NX in Radiant Software:
DSP_Mult_Accumulate

N/A
accumsload
addnsub_i
input_a_i
input_b_i
Id

N/A

N/A
result_o
N/A

N/A

N/A

DSP Multiply Add Subtract

Table 21: Feature Compatibility

Feature

Enable Cascade Input
Input AO/A1 Width
Input BO/B1 Width
Data Type A

Data Type B

Reset Mode

Input AO Source
Input A1 Source

Input BO Source

Input B1 Source
Select Shift Out A
Cascade Match Register
Select Shift Out B
Add/Sub Operation

ECP5 in Diamond: multaddsub

Check box

2-72

2-72

Signed, Unsigned, Dynamic
Signed, Unsigned, Dynamic
SYNC, ASYNC

Parallel, Shift, Dynamic
Parallel, Shift, Dynamic
Parallel, Shift, Dynamic
Parallel, Shift, Dynamic
Check box

Check box

Check box

Add, Sub, Dynamic

CrossLink-NX in Radiant Software:

DSP_Mult_Add_Sub
N/A

2-72

2-72

Signed, Unsigned
Signed, Unsigned
SYNC, ASYNC
N/A

N/A

N/A

N/A

N/A

N/A

N/A

N/A4
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Table 21: Feature Compatibility (Continued)

Feature

Input Register A

Input A Clock

Input A Clock Enable
Input A Reset

Input Register B

Input B Clock

Input B Clock Enable
Input B Reset

Input Register ABO

Input Register AB1
Pipeline Mode

Enable Pipeline Register
Output Register

Output Clock

Input Output Clock Enable
Bus Ordering Style

ECP5 in Diamond: multaddsub

Check box

CLKO, CLK1

CEO, CE1, CE2, CE3
RSTO, RST1

Check box

CLKO, CLK1

CEO, CE1, CE2, CE3
RSTO, RST1

N/A

N/A

Check box

Check box

Check box

InputA, InputB

CEO, CE1, CE2, CE3

Big Endian, Little Endian, None

CrossLink-NX in Radiant Software:
DSP_Mult_Add_Sub

N/A
N/A

N/A 2

N/A 3

N/A

N/A '

N/A 2

N/A 3
Check box
Check box
N/A
Check box
Check box
N/A

N/A 2

N/A

1 Two clocks were used in ECPS5. However, CrossLink-NX DSP primitives only use a

single clock for input and output.

2 ECP5 has four selectable clock enables (CEO, CE1, CE2, and CE3). In CrossLink-
NX DSPs, the clock enables are already designated (ce_a_i for input A, ce_b_i for
input B, ce_p_i for pipeline, and ce_o_i for output).

3 Two resets are used in ECP5. However CrossLink-NX uses designated resets for
input and output (rst_a_i for input A, rst_b_i for input B, rst_p_i for pipeline, and rst_o

_i for output).

4 The Add/Sub operation in the Radiant software is always dynamic.

Table 22: Port Compatibility
ECP5 in Diamond: multaddsub

CLKO
CLK1
N/A
CEO
CE1

CrossLink-NX in Radiant Software:
DSP_Mult_Add_Sub

N/A
N/A
clk_i
N/A
N/A
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Table 22: Port Compatibility (Continued)

ECP5 in Diamond: multaddsub CrossLink-NX in Radiant Software:
DSP_Mult_Add_Sub

CE2 N/A

CE3 N/A

N/A ce_a_i
N/A ce_b_i
N/A ce_p_i
N/A ce o i
RSTO N/A

RST1 N/A

N/A rst_a_i
N/A rst_b_i
N/A rst_p_i
N/A rst o i
SignA N/A

SignB N/A
ShiftAO N/A
ShiftA1 N/A
ShiftB0 N/A
ShiftB1 N/A
SourceA N/A
SourceB N/A
ADDNSUB addnsub_i
AO input_0_i
A1 input_a1t_i
BO input_b0 _i
B1 input_b1 i
SRIA N/A

SRIB N/A

CIN N/A
SignCIN N/A
SignSUM N/A
SROA N/A
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Table 22: Port Compatibility (Continued)

ECP5 in Diamond: multaddsub CrossLink-NX in Radiant Software:
DSP_Mult_Add_Sub

SROB N/A
SUM result_o

DSP Multiply Add Subtract Sum

Added a designated clock enable and reset for input and output.

Removed for CrossLink-NX:
Select shift Out A and Select shift Out B.
Add/Sub 0 Operation (Add, Sub, or Dynamic).
Add/Sub 1 Operation (Add, Sub, or Dynamic).

Input Source A0, A1, A2, A3, BO, B1, B2, and B3 (Parallel, Shift, or
Dynamic).

Bus Ordering style not supported by primitive.
Dynamic mode removed from Data Type.
Ports:

SROA (Shift Output)

SROB (Shift Output)

OVERFLOW

SourceA

SourceB

SignA

SignB

SRIA

SRIB (Shift Input)

Modified for CrossLink-NX:

Multiple clock support to single clock. Special primitive only uses single
clock.

Lattice Radiant Software Guide for Lattice Diamond Users 28



MIGRATING DESIGNS FROM DIAMOND TO CROSSLINK-NX ON THE RADIANT SOFTWARE : DSP Arithmetic IP

DSP Multiplier

Table 23: Feature Compatibility

Feature ECP5 in Diamond: mult CrossLink-NX in Radiant Software:
DSP_Multiplier

Input Width 2-72 2-72

Data Type Signed, Unsigned, Dynamic Signed, Unsigned

Source Parallel, Shift, Dynamic N/A

Select Shift Out A Check box N/A

Select Shift Out B Check box N/A

Input Register A Check box Check box

Input A Clock CLKO, CLK1 N/A '

Input A Clock Enable CEOQ, CE1, CE2, CE3 N/A 2

Input A Reset RSTO, RST1 N/A 3

Input Register B Check box Check box

Input B Clock CLKO, CLK1 N/A !

Input B Clock Enable CEO, CE1, CE2, CE3 N/A 2

Input B Reset RSTO, RST1 N/A 3

Pipeline Mode Check box N/A

Pipeline Register Check box N/A

Output Register Check box Check box

Bus Ordering Style Big Endian, Little Endian, None N/A

" Two clocks were used in ECP5. However, CrossLink-NX DSP primitives only use a
single clock for input and output.

2 ECPS5 has four selectable clock enables (CEOQ, CE1, CE2, and CE3). In CrossLink-
NX DSPs, the clock enables are already designated (ce_a_i for input A, ce_b_i for
input B, and ce_o_i for output).

3 Two resets are used in ECP5. However CrossLink-NX uses designated resets for
input and output (rst_a_i for input A, rst_b_i for input B, and rst_o _i for output).

Table 24: Port Compatibility

ECP5 in Diamond: mult CrossLink-NX in Radiant Software:

DSP_Multiplier
CLKO N/A
CLK1 N/A
N/A clk_i
CEO N/A
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Table 24: Port Compatibility (Continued)

ECP5 in Diamond: mult CrossLink-NX in Radiant Software:
DSP_Multiplier
CE1 N/A
CE2 N/A
CE3 N/A
N/A ce_a_i
N/A ce b i
N/A ce o i
RSTO N/A
RST1 N/A
N/A rst_a_i
N/A rst_b_i
N/A rst o i
SignA N/A
SignB N/A
SourceA N/A
SourceB N/A
A input_a_i
B input_b_i
SRIA N/A
SRIB N/A
P result_o
SROA N/A
SROB N/A
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Memory IP

The types of memory available in the Radiant software are very similar to
what is available in Diamond. All the IP available in Diamond have
equivalents in the Radiant IP Catalog. Design differences are just in the
names and a few options.

If a memory initialization file is needed, create one before configuring the IP.
Each row includes the value to be stored in a particular memory location. The
file name for the memory initialization file is *.mem (<file_name>.mem).

FIFO

Removed for CrossLink-NX:
ECC
ERROR port

Table 25: Feature Compatibility

Feature

CrossLink and ECP5 in Diamond:
fifo

CrossLink-NX in Radiant Software:
FIFO

FIFO Implementation
Address Depth
Data Width

Total Memory bits

Enable Output Register
Controlled by RdEn

Flag Control: Aimost Empty Flag

Flag Control:

Flag Control: Assert
Flag Control: Deassert

Flag Control: Aimost Full Flag

Flag Control

EBR Only, LUT Only
2-65536

1-256

N/A

Check box
Check box
Check box

Static - Single Threshold,
Static - Dual Threshold,
Dynamic - Single Threshold,
Dynamic - Dual Threshold

1-512
1-512
Check box

Static - Single Threshold,
Static - Dual Threshold,
Dynamic - Single Threshold,
Dynamic - Dual Threshold

EBR, LUT (Implementation Type)
2-65536
1-256

Calculated value from Address Depth
and Data width

Check box
N/A

Check box (Enable ALMOST EMPTY
flag)

Static - Single Threshold,

Static - Dual Threshold,

Dynamic - Single Threshold,
Dynamic - Dual Threshold
(ALMOST EMPTY assertion type)

1-1023 (Assert LEVEL)
2-1022 (Deassert LEVEL)

Check box (Enable ALMOST FULL
assertion flag)

Static - Single Threshold,

Static - Dual Threshold,
Dynamic - Single Threshold,
Dynamic - Dual Threshold
(ALMOST FULL assertion type)
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Table 25: Feature Compatibility (Continued)

Feature

Flag Control: Assert
Flag Control: Deassert
Reset Mode: Assertion
Reset Mode: Release
Reset Assertion

Data Count (Synchronized with Write
Clock)

Enable ECC (not supported for Data
Width > 64)

Bus Ordering Style

CrossLink and ECP5 in Diamond:
fifo

1-512

1-512
Async, Sync
Async, Sync
N/A

Check box

Check box

Big Endian, Little Endian, None

FIFO DC

Removed for CrossLink-NX:
ECC
ERROR port

Table 26: Feature Compatibility

Feature

CrossLink and ECP5 in Diamond:
fifo_dc

CrossLink-NX in Radiant Software:
FIFO

2-1023 (Assert LEVEL)
1-1022 (Deassert LEVEL)
N/A

N/A

sync, async

Check box (Enable Data Count)

N/A

N/A

CrossLink-NX in Radiant Software:
FIFO_DC

FIFO Implementation
Write Address Depth
Data Width
Read Address Depth
Data Width

Total Memory bits

Enable Output Register
Controlled by RdEn

Flag Control: Aimost Empty Flag

Flag Control

EBR Only, LUT Only
2-65536

1-256

2-65536

1-256

N/A

Check box
Check box
Check box

Static - Single Threshold,
Static - Dual Threshold,
Dynamic - Single Threshold,
Dynamic - Dual Threshold

EBR, LUT (Implementation Type)
2-65536 (Write Port: Address Depth)
1-256 (Write Port Data Width)
2-65536 (Read Port: Address Depth)
1-256 (Read Port: Data Width)

Calculated value from Address Depth
and Data width

Check box
N/A

Check box (Enable ALMOST EMPTY
flag)

Static - Single Threshold,

Static - Dual Threshold,

Dynamic - Single Threshold,
Dynamic - Dual Threshold
(ALMOST EMPTY assertion type)
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Table 26: Feature Compatibility (Continued)

Feature

Flag Control: Assert
Flag Control: Deassert

Flag Control: Almost Full Flag

Flag Control

Flag Control: Assert
Flag Control: Deassert
Reset Mode: Assetion
Reset Mode: Release
Reset Assertion

Data Count (Synchronized with Write
Clock)

Data Count (Synchronized with Read
Clock)

Enable ECC (not supported for Data
Width > 64)

Bus Ordering Style

CrossLink and ECP5 in Diamond:
fifo_dc

1-512
1-512
Check box

Static - Single Threshold,
Static - Dual Threshold,
Dynamic - Single Threshold,
Dynamic - Dual Threshold

1-512

1-512
Async, Sync
Async, Sync
N/A

Check box

Check box

Check box

Big Endian, Little Endian, None

CrossLink-NX in Radiant Software:
FIFO_DC

1-511 (Assert LEVEL)
2-511 (Deassert LEVEL)

Check box (Enable ALMOST FULL
flag)

Static - Single Threshold,

Static - Dual Threshold,
Dynamic - Single Threshold,
Dynamic - Dual Threshold
(ALMOST FULL assertion type)

1-511 (Assert LEVEL)
1-510 (Deassert LEVEL)
N/A

N/A

sync, async

Check box (Enable Data Count
(Write))

Check box (Enable Data Count
(Read))

N/A

N/A

RAM-Based Shift Register

Removed for CrossLink-NX:

Variable (lossy) configuration

Memory initialization

Table 27: Feature Compatibility

Feature CrossLink and ECP5 in Diamond:  CrossLink-NX in Radiant Software:
ram-based_shift_register Shift_Register

Max Shift N/A 2-8192

Data Width 1 to 256 1-256

Ram Type LUT Based, EBR Based EBR, LUT (Implementation Type)

Shift Register Type

Fixed Length,
Variable Length (Lossy),
Variable Length (Lossless)

fixed, variable
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Table 27: Feature Compatibility (Continued)

Feature

Shift Register Type: Fixed Length

Shift Register Type: Variable Length
(Lossy)

Shift Register Type: Variable Length
(Lossless)

Total Memory bits

Enable Output Register
Memory File

Memory Initialization
Memory File Format

Bus Ordering Style

CrossLink and ECP5 in Diamond:
ram-based_shift_register

2-1024
2-1024

2-1024

N/A

Check box

User input

N/A

Binary, Hex, Addressed Hex

Big Endian, Little Endian, None

Distributed DPRAM

Added rd_clock port. However, you must still handle clock crossing between
addresses.

Table 28: Feature Compatibility

Feature

CrossLink and ECP5 in Diamond:
distributed_dpram

CrossLink-NX in Radiant Software:
Shift_Register

N/A
N/A

N/A

Calculated value from Address Depth
and Data width

Check box
N/A
N/A
N/A
N/A

CrossLink-NX in Radiant Software:
Distributed_DPRAM

Address Depth
Data Width
Read Port: Address Depth

Read Port: Data Width

Enable Output Register

Reset Assertion
Memory File

Memory Initialization

Memory File Format

Bus Ordering Style

2-8192
1-256
N/A

N/A
Check box

N/A
User input

N/A

Binary, Hex, Addressed Hex
Big Endian, Little Endian, None

2-32768 (Write Port: Address Depth)
1-512 (Write Port: Data Width)

Same value as Write Port: Address
Depth

Same value as Write Port: Data Width

Check box (Read Port: Enable Output
Register)

sync
User input

none, Initialize all to Os,
Initialize all to 1s, Memory File

hex, binary
N/A
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Distributed SPRAM

Table 29: Feature Compatibility

Feature

CrossLink and ECP5 in Diamond:

distributed_spram

CrossLink-NX in Radiant Software:
Distributed_SPRAM

Address Depth
Data Width

Total Memory bits

Enable Output Register
Reset Assertion
Memory File

Memory Initialization

Memory File Format

Bus Ordering Style

2-8192
1-256
N/A

Check box
N/A
User input

N/A

Binary, Hex, Addressed Hex
Big Endian, Little Endian, None

Table 30: Feature Compatibility

Feature

Distributed ROM

CrossLink and ECP5 in Diamond:

distributed_rom

2-8192
1-256

Calculated value from Address Depth
and Data width

Check box
sync, async
User input

none, Initialize all to Os,
Initialize all to 1s, Memory File

hex, binary

N/A

CrossLink-NX in Radiant Software:
Distributed_ROM

Address Depth
Data Width

Total Memory bits

Enable Output Register

Reset Assertion
Memory File

Memory Initialization

Memory File Format

Bus Ordering Style

2-8192
1-128
N/A

Check box

N/A
User input

N/A

Binary, Hex, Addressed Hex
Big Endian, Little Endian, None

2-65536 (Read Port: Address Depth)
1-512 (Read Port: Data Width)

Calculated value from Address Depth
and Data width

Check box (Read Port: Enable Output
Register)

sync, async
User input

none, Initialize all to Os,
Initialize all to 1s, Memory File

hex, binary
N/A
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RAM DP

Removed for CrossLink-NX:
ECC
ERROR port

Table 31: Feature Compatibility

Feature

CrossLink and ECP5 in Diamond:
ram_dp

CrossLink-NX in Radiant Software:
RAM_DP

Read Port
Address Depth
Data Width
Write Port
Address Depth
Data Width

Total Memory bits

Provide Byte Enables
Byte Size

Enable Output Register
Enable Output ClockEn
Optimization

Reset Mode

Release

Enable Byte Enable

Initialization

Memory File Format

Enable ECC (not supported for Data
Width > 64)

Pipeline Stages for Q and ERROR
Outputs

Bus Ordering Style

2-65536
1-256

2-65536
1-256
N/A

Check box
8,9

Check box
Check box
Area, Speed
Async, Sync
Async, Sync
N/A

Initialize to all O’s, Initialize to all 1’s,
Memory File

Binary, Hex, Addressed Hex
Check box

0-2

Big Endian, Little Endian, None

2-65536 (Read Port: Address Depth)
1-256 (Read Port: Address Depth)

2-65536 (Read Port: Address Depth)
1-256 (Read Port: Address Depth)

Calculated value from Address Depth
and Data width

N/A

N/A

Check box
Check box
N/A

sync, async
N/A

Check box

none, Initialize all to Os,
Initialize all to 1s, Memory File

hex, binary
Check box (Enable ECC)

N/A

N/A

RAM DP True

Removed for CrossLink-NX:
ECC
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Read-Before-Write
Write through
ERROR port

Table 32: Feature Compatibility

Feature

CrossLink and ECP5 in Diamond:
ram_dp_true

CrossLink-NX in Radiant Software:
RAM_DP_True

A Port: Address Depth
A Port: Data Width
A Port: Enable Output Register

A Port: Enable Output ClockEn
B Port: Address Depth
B Port: Data Width

B Port: Enable Output Register

B Port: Enable Output ClockEn

Total Memory bits

Provide Byte Enables
Byte Size

Optimization

Reset Mode

Reset Assertion (A)
Reset DeAssertion (A)
Reset Assertion (B)
Reset DeAssertion (B)
Release

Enable Byte Enable (A)
Enable Byte Enable (B)

Initialization

Memory File Format

Enable ECC (not supported for Data
Width > 64)

Pipeline Stages for Q and ERROR
Outputs

Bus Ordering Style

2-65536
1-256
Check box

Check box
2-65536
1-256
Check box

Check box
N/A

Check box
8,9

Area, Speed
Async, Sync
N/A

N/A

N/A

N/A

Async, Sync
N/A

N/A

Initialize to all O’s, Initialize to all 1’s,
Memory File

Binary, Hex, Addressed Hex
Check box

0-2

Big Endian, Little Endian, None

2-65536 (Read Port: Address Depth)
1-256 (Read Port: Address Depth)

Check box (Read Port: Enable Output
Register (A)

N/A
2-65536 (Read Port: Address Depth)
1-256 (Read Port: Address Depth)

Check box (Read Port: Enable Output
Register (B)

N/A

Calculated value from Address Depth
and Data width

N/A
N/A
N/A
N/A
sync, async
sync, async
sync, async
sync, async
N/A
Check box
Check box

none, Initialize all to Os,
Initialize all to 1s, Memory File

hex, binary

Check box (Enable ECC)

N/A

N/A
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Memory IP

Table 32: Feature Compatibility (Continued)

Feature

Port A Write Mode

Port B Write Mode

CrossLink and ECP5 in Diamond:
ram_dp_true

Normal, Write Through, Read before
Write

Normal, Write Through, Read before
Write

CrossLink-NX in Radiant Software:
RAM_DP_True

N/A

N/A

RAM DQ

Removed for CrossLink-NX:
ECC
Read-Before-Write
Write through
ERROR port

Modified for CrossLink-NX:

Byte-Enable is supported, however the Radiant software automatically
applies the byte-width. Nine is used when data_width is divisible by 9, and
8 is used when data_width is divisible by 8, with 9 being priority. So for
configurations divisible with both (for example, DWID = 72), the byte-width
is 9.

Table 33: Feature Compatibility

Feature

CrossLink and ECP5 in Diamond:
ram_dq

CrossLink-NX in Radiant Software:
RAM_DQ

Address Depth
Data Width

Total Memory bits

Provide Byte Enables
Byte Size

Enable Output Register
Enable Output ClockEn
Optimization

Reset Mode

Release

Enable Byte Enable

Initialization

2-65536
1-256
N/A

Check box
8,9

Check box
Check box
Area, Speed
Async, Sync
Async, Sync
N/A

Initialize to all O’s, Initialize to all 1’s,
Memory File

2-65536
1-512

Calculated value from Address Depth
and Data width

N/A

N/A

Check box
Check box
N/A

sync, async
N/A

Check box

none, Initialize all to Os,
Initialize all to 1s, Memory File
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Memory IP

Table 33: Feature Compatibility (Continued)

Feature

Memory File Format

Enable ECC (not supported for Data
Width > 64)

Bus Ordering Style

CrossLink and ECP5 in Diamond:

ram_dq
Binary, Hex, Addressed Hex

Pipeline Stages for Q and ERROR
Outputs (0, 1, 2)

Big Endian, Little Endian, None

CrossLink-NX in Radiant Software:
RAM_DQ

hex, binary
N/A

N/A

ROM

Removed for CrossLink-NX:
ECC
ERROR port

Table 34: Feature Compatibility

Feature

CrossLink and ECP5 in Diamond:

CrossLink-NX in Radiant Software:

rom ROM
Address Depth 2-65536 2-65536
Data Width 1-256 1-512
Enable Output Register Check box Check box
Enable Output ClockEn Check box Check box
Total Memory bits N/A Calculated value from Address Depth

and Data width

Optimization Area, Speed N/A
Reset Mode : Assetion Async, Sync N/A
Reset Mode : Release Async, Sync N/A
Reset Assertion N/A sync, async
Memory File User input User Input
Memory File Format Binary, Hex, Addressed Hex hex, binary
Enable ECC (not supported for Data Check box N/A
Width > 64)
Pipeline Stages for Q and ERROR 0-2 N/A
Outputs
Bus Ordering Style Big Endian, Little Endian, None N/A
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PMI

This section describes changes to CrossLink-NX PMI as compared to ECP5
PMI.

Arithmetic PMI

Table 35: Changes to Arithmetic PMI for CrossLink-NX vs ECP5

PMI

pmi_add

pmi_addsub

pmi_complex_mult
pmi_counter

pmi_mac

pmi_mult
pmi_multaddsub
pmi_multaddsubsum

pmi_sub

Changes

.pmi_result_width()

This parameter is not used in CrossLink-NX but retained for compatibility with ECP5 PMI.
The user need not specify the result width. The value of "pmi_data_width" is used for
both input and output width.

.pmi_result_width()

This parameter is not used in CrossLink-NX but retained for compatibility with ECP5 PMI.
The user need not specify the result width. The value of "pmi_data_width" is used for
both input and output width..

Cin and Cout ports are both active-high regardless of the value of Add_Sub. See
example in Table 36 below.

None
None

Definition change for pmi_accum_width. It must be wider than (pmi_dataa_width +
pmi_datab_width) by 1 to 32 bits.

None
None
None

.pmi_result_width()

This parameter is not used in CrossLink-NX but retained for compatibility with ECP5 PMI.
The user need not specify the result width. The value of "pmi_data_width" is used for
both input and output width.

Cin port is active-high. See example in Table 36 below.
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PMI

Table 36: Arithmetic PMI Examples

ECP5UM for pmi_addsub:

pmi_addsub #
(.pmi data width (8),

.pmi result width (8),

.pmi_sign ("off"),

.pmi_ family ("common"),

.module type ( )
) ul addsub8
(.DataA (Datahd),

.DataB (DataB),

.Cin ((AddSub) ? Cin
.Add_Sub (AddSub) ,
.Result (Result),

.Cout (Cout int),

.Overflow()
);

assign Cout = (AddSub) ? Cout int

CrossLink-NX for pmi_addsub:

pmi_addsub # (
.pmi_data width (8),
.pmi_result width (
.pmi_sign ("off"),

.pmi family ("common"),
.module type ( )

) ul addsub8

(

.DataA (Datahd),
.DataB (DataB),
.Cin (Cin),
.Add_Sub (AddSub) ,
.Result (Result),
.Cout (Cout int),
.Overflow()

)

assign Cout = Cout int;

I'Cin),

!Cout_int;
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PMI

Table 36: Arithmetic PMI Examples (Continued)
ECP5UM for pmi_sub:

pmi_sub #
(.pmi data width (8),
.pmi result width (8),
.pmi_sign ("off"),
.pmi_ family ("common"),
.module type ( )

) ul sub8

(.DataA (Datahd),
.DataB (DataB),
.Cin ('Cin),
.Result (Result),
.Cout (Cout),

.Overflow()
)

CrossLink-NX for pmi_sub:

pmi sub #(
.pmi_data width (8),
.pmi_result width ( ),
.pmi_sign ("off"),
.pmi_ family ("common"),
.module type ( )

) ul sub8

(

.DataA (Datald),
.DataB (DataB),
.Cin (Cin),
.Result (Result),
.Cout (Cout),

.Overflow()
);

DSP PMI

Table 37: Changes to DSP PMI for CrossLink-NX vs ECP5

PMI

pmi_dsp_camultaddsub

pmi_dsp_mac

pmi_dsp_mult

pmi_dsp_multaddsub

Changes

This is not supported in CrossLink-NX. The user is recommended to port their design
using DSP_Mult_Add_Sub module from IP Catalog.

This is not supported in CrossLink-NX. The user is recommended to port their design
using DSP_Mult_Accumulate module from IP Catalog.

This is not supported in CrossLink-NX. The user is recommended to port their design
using DSP_Multiplier module from IP Catalog.

This is not supported in CrossLink-NX. The user is recommended to port their design
using DSP_Mult_Add_Sub module from IP Catalog.
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Table 37: Changes to DSP PMI for CrossLink-NX vs ECP5 (Continued)

PMI

pmi_dsp_multaddsubsum

pmi_dsp_preadd_slice

Changes

This is not supported in CrossLink-NX. The user is recommended to port their design
using DSP_Mult_Add_Sub_Sum module from IP Catalog.

This is not supported in CrossLink-NX. The user is recommended to port their design
using user primitives available in CrossLink-NX.

Memory PMI

Table 38: Changes to Memory PMI for CrossLink-NX vs ECP5

PMI
pmi_distributed_dpram
pmi_distributed_rom
pmi_distributed_shift_reg
pmi_distributed_spram

pmi_fifo

Changes
None
None
None
None

.pmi_implementation(), //"LUT", "EBR", "Hard_IP"

New parameter value "Hard_IP" added to Crosslink-NX. When "Hard_IP" value is used,
the implementation is faster and uses less LUTs, but may consume additional EBR
resources depending on configuration.

.pmi_data_depth()

When "Hard_IP" value is passed through as a parameter for "pmi_implementation”, the
user is no longer limited by 2*n configurations.

.pmi_full_flag().

This parameter is not a user parameter for Crosslink-NX. The parameter is used in the IP,
but the IP would use the value of pmi_data_depth instead. It is suggested to leave the
value blank when migrating ECP5 based designs.

.pmi_empty_flag()

This parameter is not a user parameter for Crosslink-NX. The parameter is used in the IP,
.pmi_empty_flag() is initialized to "0".
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Table 38: Changes to Memory PMI for CrossLink-NX vs ECP5 (Continued)

PMI

pmi_fifo_dc

pmi_ram_dp

pmi_ram_dp_be

pmi_ram_dp_true

pmi_ram_dq

pmi_ram_dq_be

pmi_rom

Notes:

Changes
.pmi_implementation(), //"LUT", "EBR", "Hard_IP"

New parameter value "Hard_IP" added to Crosslink-NX. When "Hard_|IP" value is used,
the implementation is faster and uses less LUTs, but may consume additional EBR
resources depending on configuration. No latency is present when using "Hard_IP" and
dual-clocks.

.pmi_data_depth_w()

When "Hard_IP" value is passed through as a parameter for "pmi_implementation", the
user is no longer limited by 2*n configurations.

.pmi_data_depth_r()

When "Hard_IP" value is passed through as a parameter for "pmi_implementation", the
user is no longer limited by 2*n configurations.

.pmi_full_flag().

This parameter is not a user parameter for Crosslink-NX. The parameter is used in the IP,
but the IP would use the value of pmi_data_depth instead. It is suggested to leave the
value blank when migrating ECP5 based designs.

.pmi_empty_flag()

This parameter is not a user parameter for Crosslink-NX. The parameter is used in the IP,
.pmi_empty_flag() is initialized to "0".

Limitation for Crosslink-NX: cannot be initialized when mixed-width is used.

Use pmi_family = "LFD2NX" / "LIFCL" if mixed-width is required, otherwise use pmi_family
= "common". (30-bits minimum required for pmi_family = "common").

Limitation: cannot be initialized. User must specify correct device family code in order to
be implemented properly.

Limitation for Crosslink-NX: cannot be initialized when mixed-width is used.

Use pmi_family = "LFD2NX" / "LIFCL" if mixed-width is required, otherwise use pmi_family
= "common". (30-bits minimum required for pmi_family = "common").

Use pmi_family = "common" if initialization is needed. (30-bits minimum required for
pmi_family = "common").

Limitation: cannot be initialized. User must specify correct device family code in order to
be implemented properly.

Use pmi_family = "common". (30-bits minimum required).

All IPs are functionally equivalent to ECP5.

30-bit limitation refers to memory size: data_width * addr_depth.
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PMI

PLL PMI

Table 39: Changes to PLLPMI for CrossLink-NX vs ECP5
PMI Changes

pmi_pll This is not supported in CrossLink-NX. The user is recommended to port their design
using PLL module from IP Catalog.

pmi_pll_fp This is not supported in CrossLink-NX. The user is recommended to port their design
using PLL module from IP Catalog.

Lattice Radiant Software Guide for Lattice Diamond Users

45



MIGRATING DESIGNS FROM DIAMOND TO CROSSLINK-NX ON THE RADIANT SOFTWARE : Primitives

Primitives
The following general guidelines are recommended:

For primitives that are inferable by the synthesis tool (LUT, I/O, RAM, and
so on), let the synthesis tool infer them rather than directly instantiating
them.

If synthesis inference is not sufficient or is not available for a certain
primitive, use the Radiant IP Catalog tool rather than directly instantiating
the primitive.

If direct instantiation is required, use the Radiant Source Template tool to
help instantiate the primitive. Note that some primitives do not have direct
equivalents between Diamond and the Radiant software.

For ease-of-use, you can instantiate the primitives from the Source Template.

For more information on the Radiant primitives, see the Radiant Help under
References > FPGA Libraries Reference Guide.

GSR

When migrating the designs from Diamond software to Radiant software,
please note the GSR instantiation changes as below:

GSR in Radiant has an added parameter “SYNCMODE”. By default the

SYNCMODE is set to “ASYNC”. For further details on using the GSR in
Radiant, please refer to the Radiant help.

Table 40: GSR Instantiation

Diamond Radiant Software Example in Diamond Example in Radiant
GSR GSR_INST (.GSR()); GSR GSR GSR_INST( GSR GSR_INST

#( .GSR(rst)); (

.SYNCMODE () .GSR_N(rst),

) <your_inst_label> ( .CLK(clk)

.GSR_N (), //'| );

.CLK () /'l

);

Buffers

The Diamond and Radiant software share four basic 1/O buffers:
IB, Input Buffer
OB, Output Buffer
OBZ, Output Buffer with Tristate
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BB, Bidirectional Buffer

No changes are needed to migrate these buffers to a Crosslink-NX design.
See the following table for coding examples.

Table 41: Buffer Coding Examples

1/0 Buffer

Input Buffer

Output Buffer

Output Buffer with Tristate

Bidirectional Buffer

Table 42: I/O Registers

Diamond Radiant
Software
IFS1P3BX IFD1P3BX
IFS1P3DX IFD1P3DX
IFS1P3IX IFD1P3IX

IFS1P3JX 1FD1P3JX

OFS1P3BX  OFD1P3BX

Instantiation Examples Inference Examples

IBu_IB (

1 (reset), // 1

.O (reset_c)// O
);

OB u_OB (
d(a_in), /11
.O(a_out)// O
);

OBZ u_OBZ ( assign output_o = enable ? input_i : 1'bz;
A (input_i), // 1

.T (enable), // |, tristate

.O (output_o) // O, port pin

)

BB u_BB ( assign out_o = enable ? input_i :3 1'bz;
1 (input_i), // 1, active-low tristate assign bidir = out_o;

.T (enable), // 1, from fabric

.O (out_o), // O, to fabric

.B (bidir) // 10, port pin

);

/0 Registers

The 1/O registers inferred in the Radiant software for CrossLink-NX are similar
to the ones inferred in Diamond for CrossLink and ECP5. The table below
shows the available 1/O registers for ECP5, CrossLink, and CrossLink-NX.

Radiant Description

Positive Edge Triggered Input D Flip-Flop with Positive Level Enable and Positive
Level Asynchronous Preset

Positive Edge Triggered Input D Flip-Flop with Positive Level Enable and Positive
Level Asynchronous Clear

Positive Edge Triggered Input D Flip-Flop with Positive Level Synchronous Clear and
Positive Level Enable (Clear overrides Enable)

Positive Edge Triggered Input D Flip-Flop with Positive Level Synchronous Preset
and Positive Level Enable (Preset overrides Enable)

Positive Edge Triggered Output D Flip-Flop with Positive Level Enable and Positive
Level Asynchronous Preset
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Table 42: 1/0 Registers (Continued)

Diamond Radiant
Software

OFS1P3DX OFD1P3DX

OFS1P3IX OFD1P3IX

OFS1P3JX OFD1P3JX

Radiant Description

Positive Edge Triggered Output D Flip-Flop with Positive Level Enable and Positive
Level Asynchronous Clear

Positive Edge Triggered Output D Flip-Flop with Positive Level Synchronous Clear
and Positive Level Enable (Clear overrides Enable)

Positive Edge Triggered Output D Flip-Flop with Positive Level Synchronous Preset
and Positive Level Enable (Preset overrides Enable)

Block RAM (EBR)

In the Radiant software, a block RAM can be configured and generated using
IP Catalog, inferred from RTL code, or instantiated using primitives.
Instantiating an EBR primitive should be done only if there is a need for a
special function.

If a specific size or type of memory function is to be generated, use IP
Catalog. For an existing ECP5 design, if the EBR module was generated
using Clarity Designer, you need to regenerate the IP using IP Catalog. See
“‘Memory IP” on page 31.

Inferring EBR

EBR blocks inferred by the synthesis tool are totally dependent on the style of
the RTL coding. As an example, the following RTL code infers a single-clock
pseudo dual port RAM (the PDPSC16K primitive).

H
il

[7:0] mem [127:0]
[7:0] data_out:

H

il
W

always® (posedge clk) if(we == 1) data_out <= data out;
£l3e data_out <= mem[addr]:

always @(posedge clk) if (we) mem[addr] <= data_in:
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To infer a PDP16K primitive, the RTL design must have a read-and-write clock
as shown in the example below:

wire [&:0] wr_addr,
wire [T7:0] wWr_data:

reg [T7:0] rd_data:

reg [511:0] mem [7:0]:
always B (possdge wr_clk)

rd_addr:

if (wr_en) mem[wr_addr] <= wr_data:

always [

if (rd _en)

(posedge rd clk)
rd data <= mem[rd_addr]:

Instantiating EBR Primitives
Instantiation of EBR primitives is only recommended when there is a need for

a special function or when different read/write port sizes are required. The
table below shows the EBR primitives for CrossLink and ECP5 in Diamond

and CrossLink-NX in the Radiant software:

CrossLink

DP8KE, PDPW16KD

Instantiate PDP16K, which supports 16Kx1, 8Kx2, 4Kx4, 2Kx9, 1Kx18, or
512x36 memory configurations, using DATA WIDTH_W and

DATA_WDTH_R.

Data Width Input Data
16Kx1 DI[0]

8Kx2 DI[1:0]
4Kx4 DI[3:0]
2Kx9 DI[8:0]
1Kx18 DI[17:0]
512x36 DI[35:0]

ECP5
DP16KD, PDPW16KD

Output Data

DOI0]
DO[1:0]
DO[3:0]
DOI8:0]
DO[17:0]
DOI[35:0]

CrossLink-NX

PDP16K,

PDP16K_MODE,
PDPSC16K, PDPSC512K,
SP16K, SP512K,
DPSC512K

Write Address Read Address

(MSB to LSB)

ADW[13:0]
ADW[13:1]
ADW[13:2]
ADW[13:3]
ADW[13:4]
ADW[13:4]

(MSB to LSB)

ADR[13:0]
ADR[13:1]
ADR[13:2]
ADR[13:3]
ADR[13:4]
ADR[13:4]
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Below is an instantiation example of PDP16K:

PDP16K #
.DATA WIDTH W (2),
.DATE_WIDTH_R (3}

) u_PDEl6K(
.DI (wr_data_map) , I, 16
ADH ({({2'k0, wr_addr[3:0]}), /I, 11-bi
LADR ({2'b0, rd_addr[E8:0]}), /f I, 11-bit address

CLEW (wr_clk),
.CLER (rd_clk),
CEW (1'bl),

.CER ({1'bl),

LC5W  (c3_w),

.C5R  (ca_r),

.R5T (rst),

DD (rd_data_ map)

o H H H H H H H

&-bit data

DSP Functions

In Diamond, an inferred DSP block remains the same post-synthesis and
post-route. But, for CrossLink-NX in the Radiant software, the inferred DSP
function changes to hardware primitive models post-synthesis. So it is
recommended that you use IP Catalog to generate DSP functions for
CrossLink-NX instead of instantiation. See “DSP Arithmetic IP” on page 23.

Oscillator Functions

In Diamond, the oscillator function could be easily instantiated using a
primitive. But, in the Radiant software, it is highly recommended that you use
IP Catalog to configure and generate the OSC functions.

To use the internal oscillator in CrossLink-NX, use IP Catalog to generate the
OSC IP. OSC offers both high-frequency (HF CLK) or low-frequency (LFCLK)
clock outputs. Once the IP is configured, generate it and add it into the
existing Radiant project. See Figure 1.
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Figure 1: OSC Configuration Dialog Box

| Module/IP Block Wizard

= 2

Configure Component from Module osc
Please set the following parameters to configure this component.

Diagram tmp

Configure tmp:
Property Value
~ General
HFCLK Enable EMABLED

HFCLK Divider [2 - 256] 8

LFCLK Enable EMABLED
tmp
SEDCLK Enable DISABLED
hf clk_out_o
If clk out o
0sc

Mo DRC issues are found.

< Back Generate Cancel

Registers

In general, registers are inferred by the synthesis tool based on the RTL

source code. The Radiant software supports various registers. If you desire a

specific type of register function, use Source Template to instantiate it.

Here is an example of instantiating an FD1P3DX (positive-edge-triggered D

flip-flop, asynchronous reset, active-high enable) register:

FD1P3DX u_ FDIP3LDX ( .D (data_in),
LSP(en) ,
LCE{clk) ,
.CD{reset) ,
.Q(data_out)

2 H H H H
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The following table shows a list of registers available for CrossLink and ECP5
in Diamond and for CrossLink-NX in the Radiant software:

Diamond Radiant Software
FD1P3AX, FD1P3AY, FD1P3BX, FD1P3BX, FD1P3DX, FD1P3IX,
FD1P3DX, FD1P3IX, FD1P3JX, FD1P3JX, FL1P3AZ

FD1S3AX, FD1S3AY, FD1S3BX,
FD1S3DX, FD1S3IX, FD1S3JX,
FL1P3AY, FL1P3AZ, FL1P3BX,
FL1P3DX, FL1P3IY, FL1P3JY, FL1S3AX,
FL1S3AY
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Constraints

One of the more prominent differences between Lattice Diamond software
and the Radiant software is the process of constraining a design. In Lattice
Diamond, a Logical Preference File (.Ipf) was used to constrain a design by
tuning all aspects of logical, timing and physical constraints to improve
performance.

In the Radiant software, preferences have been replaced by the industry
standard Synopsys Design Constraints for ease of use and improved
compatibility with third-party vendor tools such as Synopsys Synplify Pro.

Comparing the Constraint Flows

In Lattice Diamond, all preferences are specified post-synthesis. The
synthesis flow has its own separate constraining system decoupled from the
back end. Any changes in preferences require that the synthesis flow rerun
starting from Map Design. See below.

Figure 2: Lattice Diamond Constraints Flow

LCD Editor
HDL —H SCOPE
Attributes Text Editor
Synthesis
@ AT 5 Text Editor
| ~——— =7 >
| HDL Attributes | LPF
| (NGD) | (User) -—
N J
\|—~( )
-

e

p View
Package View

—————

Place and Route

Figure 3 shows how the pre- and post-synthesis constraints are stored in the
JIdc file and then kept in the Unified Database (UDB). For other stages in the
flow, the PDC holds both post-synthesis timing and physical constraint
information. The major difference between this flow and Lattice Diamond is
that the Radiant software allows the pre-synthesis constraints to go through
the entire flow. You can maintain separate post-synthesis constraints to avoid
re-synthesis.
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Figure 3: Radiant Constraints Flow
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Radiant Constraint Tools

In Lattice Diamond, timing and physical preferences are applied using
Spreadsheet View, Package View, Netlist View, and Device View.

In the Radiant software:

Timing constraints are applied using the Timing Constraint Editors (Pre-
and Post-Synthesis).

Physical constraints are applied using the Device Constraint Editor (DCE).

Timing Constraints

As shown in Figure 3, timing constraints are managed in SDC format in an
fdc file for Synopsys Synplify Pro synthesis or in an .Idc file for Lattice LSE
synthesis.

The new Radiant software tools for pre- and post-synthesis timing constraints
are:

Pre-Synthesis Timing Constraint Editor (Figure 4)—Reads the HDL
designs and helps you to create timing constraints based on HDL signal,
port, and object names. The constraints are saved in an .Idc file.

Figure 4: Pre-Synthesis Timing Constraint Editor

Reports o Pre-Synthesis Timing Constraint Editor o Post-Synthesis Timing Constraint Editor « v &
Object Clock Clock Name Waveform Period (ns) Frequency (MHZ)
get_ports clk ck 05 10.000000 100
Clack Generated Clock Clock Latency Clock Uncertainty Clock Group Input/Output Delay Timing Exception o
All Constraints
create_clock -name {clk} -period 10 -waveform {0 5} [get_ports clk] Preview of entered
set_clock_latency -source 0.2 [get_clocks clk] constraints.

set_clock_uncertainty 0.3 [get_clocks clk]

Post-Synthesis Timing Constraint Editor (Figure 5)—Reads the post-
synthesis netlists and helps you to create timing constraints based on
post-synthesis netlist signal, port, and object names. The constraints are
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saved in a .pdc file. This flow allows further tuning of timing constraints for
the Place & Route process.

Figure 5: Post-Synthesis Timing Constraint Editor
CTransferred Constraints from Pre-Synthesis (Read-only}) |

Reports ° Post-Synthesis Timing Constraint Editor * e Pre-Synthesis Timing Constraint Editor

Object Clock

Clock Name Waveform Period (ns) Frequency (MHZ)

get_nets counter3/clk_1Hz 100.000000 10

Clock Generated Clock Clock Tate lock Uncertainty Clock Group Input/Output Delay Timing Exception

All Constraints | New timing constraints added, saved in .pdc file. '

create_clock -period 100 [get_nets counter3/clk_1Hz]

The updated post-synthesis timing constraints override pre-synthesis
constraints. This happens only when the same constraint is applied in post-
synthesis.

In general, physical constraints are entered in the .pdc file. Alternatively,
through a text editor, the physical constraints may also be entered in the .Idc
file. Synthesis does not consume them and transfer them to a .pdc file for
back-end consumption.

Physical Constraints

The Radiant Device Constraint Editor tool now combines the Netlist,
Package, Device, and Spreadsheet views into one GUI for the primary
purpose of entering physical (.pdc) constraints. This makes it easier to
manage multiple tools and perform such actions as cross probing between
multiple views. See Figure 6.
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Figure 6: Device Constraint Editor
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Spreadsheet View

Each of the views are used to apply constraints such as prohibiting pins and
assigning I0_TYPEs.

Note that the Floorplan View is used for creating GROUPs and REGIONSs. For
more information on Device Constraint Editor, see the Radiant software online
Help under User Guides > Applying Design Constraints > Using Radiant
Software Tools > Device Constraint Editor.

Preferences to Constraints

Table 43 shows the most commonly used Lattice Diamond physical
preference keywords and the equivalent Radiant SDC commands to create a
physical constraint.

Table 43: Lattice Diamond Preference Keywords Compared to the
Radiant SDC Commands

Lattice Diamond Radiant Software Description

Physical Preference Physical Constraint

Global, Net, and Clock Idc_set_attribute Sets global attributes or specific
Attributes attributes to the selected object.
UGROUP Idc_create_group Defines a user group.

IOBUF Idc_set_port Sets constraint attributes to the

selected port.

LOCATE Idc_set_location Places an object on a site or a
user group into a region.
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Name

bank 0
bank 1
bank 2

Global Set/Reset Net

Table 43: Lattice Diamond Preference Keywords Compared to the
Radiant SDC Commands (Continued)

Lattice Diamond Radiant Software Description
Physical Preference Physical Constraint

LOCATE VREF Idc_create_vref Defines a voltage reference site.
PROHIBIT Idc_prohibit Prohibits use of a site.

REGION Idc_create_region Defines a rectangular region.
SYSCONFIG Idc_set_sysconfig Sets SysConfig attributes.
VCC_NOMINAL Idc_set_vcc Sets a voltage to a bank or
VCC_DERATE derates the core voltage.
VOLTAGE

All physical constraints and post-synthesis timing constraints are stored in the
.pdc file.

Primary Clock Net Access

In Diamond, primary clocks are specified in a preference file (.Ipf) but in the
Radiant software, the primary clocks are specified in an .Idc file. In the
Radiant software, you can use Device Constraint Editor to set access to the
primary clock spine.

To set access to the primary clock spine:

1. Choose Tools > Device Constraint Editor.
2. Click the Global tab.

3. Double-click on Use Primary Net.

The Use Primary Net dialog box opens.

~ {Use Primary Net

- clk_c

Selection

= Bank VCCIO

BankO{\V)
Port Pin

Value
NOMINAL Use Primary Net | F i
NOMINAL .
Cleck Name Selection
NOMINAL
clk ¢ Frimary -

/A

{Frimary

Frohibit Primary
Primary
Auto ok || cancel
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4. Double-click on the desired clock net.
5. Choose Primary or Prohibit Primary from the pull-down menu.
6. Click OK.

Once the change is saved, the attribute is recorded as shown below:

#Set to use Primary clock spine
ldc_set attribute {USE PRIMARY=TRUE} [get nets clk c]

#Prohibit primary clock spine
ldc_set attribute {USE PRIMARY=FALSE} [get nets clk c]

Timing Preferences to Constraints

Table 44 shows the most commonly used Lattice Diamond timing preference
keywords and the equivalent Radiant SDC timing constraints.

Table 44: Diamond Timing Preference Keywords Compared to Radiant
SDC Timing Constraints

Lattice Diamond Radiant Software Description

Timing Preference Timing Constraint

BLOCK INTERCLOCK  set_clock_groups Defines different types of
DOMAIN clocking schemes.
BLOCK CLKNET set false path Defines false path cycles.
BLOCK PATH

CLKSKEWDISABLE

CLKSKEWDIFF set_clock_latency Defines arrival and departure
times.

CLOCK_TO_OuUT set_output_delay Defines output delay relative to
a clock.

FREQUENCY/PERIOD create_clock Defines the design clocks.

FREQUENCY/PERIOD create_generated_clock Defines generated clocks.

INPUT_SETUP set_input_delay Defines input delay relative to a
clock.

MAX_DELAY set_max_delay Defines maximum delay for
timing paths.

MAX_DELAY MIN set_min_delay Define minimum delay for timing
paths.

MULTICYCLE set_multicycle_path Defines multicycle clock cycles.

SYSTEM_JITTER set_clock_uncertainty Defines uncertainty delays.

CLOCK_JITTER

(option)
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Constraints

Note

When an INPUT_SETUP or CLOCK_TO_OUT is set in Lattice Diamond without first
specifying a clock, Lattice Diamond automatically creates a virtual clock constraint and
honors the delay. In the Radiant software, you should first define a clock
(create_clock), whether real or virtual, before using the set_input_delay or
set_output_delay constraint.

The Radiant software constraints listed in Table 45 require Tcl commands to
access object names such as cell, pin, net, port, or clock in a design.

Table 45: Tcl Commands

Object Access Types
all_clocks

all_inputs

all_outputs

get_cells

get_clocks

get_nets

get_pins

get_ports

Description

Access all clocks in a design.
Access all inputs in a design.
Access all outputs in a design.
Access cells in a design.
Access clocks in a design.
Access nets in a design.
Access pins in a design.

Access ports in a design.

Table 8 lists examples commonly used in Lattice Diamond preferences and
the equivalent Radiant software constraints in the SDC format.

Table 46: Examples of Timing Preferences in SDC Format

Lattice Diamond Preference
BLOCK PATH FROM PORT “abc” TO CELL “reg1/*;

CLKSKEWDIFF CLKPORT “clk1” CLKPORT “clk2” 2
NS;

CLKSKEWDISABLE CLKNET “clk1” CLKNET “clk2”;
CLOCK_TO_OUT PORT “out1” 8 ns CLKPORT="clk2”;

FREQUENCY (PERIOD) NET “clk1” 100Mhz;
INPUT_SETUP PORT “in_a” 4 ns CLKNET "clk1”;

MAXDELAY FROM CELL “reg1” TO CELL “reg2” 5 NS

MULTICYCLE FROM CLKNET “clk1” TO CLKNET “clk2”

2 X;
SYSTEM_JITTER 1.0 NS

1. x = clock period

Radiant Software Constraint
set_false_path -from [get_ports abc] -to [get_cells reg1]

set_clock _latency 2 -source [get_clocks clk1]

set_false_path -from [get_clocks clk1] -to [get_clocks clk2]

set_output_delay (x-8) -clock [get_clocks clk2] [get_ports
out1] 12

create_clock -period 10 -name clk1 [get_nets clk1]

set_input_delay (x-4) -clock [get_clocks clk1]
[get_ports_in_a] "2

set_max_delay 5 -from [get_cells reg1] -to [get_cells reg2]

set_multicycle_path 2 -from [get_clocks_clk1] -to
[get_clocks clk2] 2

set_clock_uncertainty 1 [get_clocks *]
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2. Set create_clock first.

For more information on the details of SDC constraints, see the Radiant Help
under Reference Guides > Constraints Reference Guide > Lattice
Synthesis Engine Constraints > Synopsys Design Constraints.

Attributes Compared

Synthesis attributes are mostly the same in both Lattice Diamond and the
Radiant software. The Radiant software does not use some attributes
because they are only for Diamond’s preference method. Also, some
attributes are for devices not supported in the Radiant software. Any attributes
not in Table 47 (below) that were in Lattice Diamond are obsolete and are not
used in the Radiant software.

Table 47: Diamond versus Radiant Attributes

Lattice Diamond Software Radiant Software

BBOX

CLAMP
DIFFRESISTOR
DRIVE
GLITCHFILTER

BBOX

CLAMP
DIFFRESISTOR
DRIVE
GLITCHFILTER

GSR GSR

HGROUP Replaced by GRP
HYSTERSIS HYSTERSIS

INIT INIT

I0_TYPE IO_TYPE

LOC LOC

NOCLIP NOCLIP
NOMERGE(SAVE) NOMERGE
OPENDRAIN OPENDRAIN
PULLMODE PULLMODE
RBBOX RBBOX

REGION REGION
SLEWRATE SLEWRATE
TERMINATION TERMINATION
UGROUP Replaced by GRP
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Table 47: Diamond versus Radiant Attributes (Continued)

Lattice Diamond Software Radiant Software
USERCODE USERCODE
VREF VREF
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Comparing Diamond and the
Radiant Software

A primary feature of the Lattice Radiant™ software is to enable Lattice
Diamond users to import their field programmable gate array (FPGA) designs
easily and seamlessly. Lattice Diamond users will quickly recognize a familiar
design environment, graphical user interface (GUI) layout, and related tools
such as Power Calculator and Reveal. However, the Radiant software
includes many significant feature enhancements from Lattice Diamond,
including:

Upgraded database to provide fast and efficient software.
IEEE 1735 standard support for encryption flow.

Constraints utilizing industry standard Synopsys Design Constraints
(SDC) format.

Efficient and easy-to-use GUI.

Unified timing analysis engine for faster design timing closure.

The objective of this guide is to help Lattice Diamond users quickly grasp the
concepts of the new features in the Radiant software.
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The following table lists major functions in a typical FPGA design flow, and

compares Lattice Diamond to the Radiant software.

Table 48: Comparison of Lattice Diamond to the Radiant Software

Design Entry

Constraints

Implementation

Lattice Diamond Design Functions

Supports hardware design languages
(HDL) such as Verilog and VHDL.

Supports primitives instantiation.

Supports soft IP and modules with IP
Express and Clarity Designer tools.

Supports Parameterized Module
Instantiation (PMI).

Supports EDIF flow.

All timing and physical constraints defined
in preferences.

Supports HDL attributes.

Supports preferences flow.

Supports standard FPGA design flow
including synthesis, map, place-and-route
(PAR), and bitgen.

Process flow supported.

Supports strategies, which are options
related to implementation tools.

Project file extension is .Idf.

Radiant Software Design Functions

Supports Verilog and VHDL. In addition, the Radiant
software provides the Source Template tool, which is

an enhanced version of Diamond’s Template Editor.
Source Template helps you implement Verilog or
VHDL language constructs, device primitives, and

PMI templates more efficiently.

See “Design Entry” on page 64.

Supports primitives instantiation.

See “Using Radiant Primitives” on page 65.

Supports soft IP and modules with IP Catalog.
See “Using Modules and Soft IP in the Radiant

Software” on page 65.

Supports PMI.

See “Using Parameterized Module Instantiation” on

page 67.
Supports VM flow.

All timing and physical constraints defined in

standard SDC.

See “Radiant Constraint Tools” on page 54.

Supports HDL attributes.

See “Design Implementation” on page 68.

Supports constraints flow.

See “Design Implementation” on page 68.

Supports standard FPGA design flow including

synthesis, map, PAR, and bitgen.

See “Lattice Diamond and the Radiant Process

Flow” on page 72.

Process flow is implemented in Process Toolbar.

See “Lattice Diamond and the Radiant Process

Flow” on page 72.

Supports strategies.

See “Design Analysis and Debug” on page 73.

Project file extension is .rdf.

See “Starting the Import Diamond Project Wizard” on

page 69.
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Table 48: Comparison of Lattice Diamond to the Radiant Software (Continued)

Lattice Diamond Design Functions

Analysis and Includes Reveal Inserter and Reveal
Debug Analyzer debug and analysis tools.

Includes Timing Analysis View.

Includes Power Calculator.

Includes Simulation Wizard.

Models of protected primitives are provided
in the form of a pre-compiled library (black
box). Only certain simulators (Active-HDL
and ModelSim) could be supported.

Tools Includes a full suite of Lattice Diamond
tools.

Design Entry

Radiant Software Design Functions

Includes Reveal Inserter and Reveal Analyzer debug
and analysis tools. Reveal Inserter also has a new
Reveal Controller module that allows you to monitor
and control status registers in hard IP such as
I2CFIFO, PLL, PCle, CDR, and DPHY.

See “Reveal” on page 73.

Includes new Timing Analysis View with new
constraints flow including Setup/Hold Endpoint
Analysis.

See “Design Analysis and Debug” on page 73.

Includes Power Calculator.

See “Power Calculator” on page 73.

Includes Simulation Wizard with the support of Post-
Synthesis Simulation.

See “Simulation Wizard” on page 73.

Models are provided in Verilog source form with
IEEE P1735 encryption. This allows all third-party
tools that support the same standard to be supported
for Radiant 2.0.

See Lattice Radiant Software 2.0 Release Notes for
a list of supported third-party tools.

Includes a full suite of Radiant tools. Some tools
have been combined for more efficiency.

See “Radiant Software Tools” on page 80.

Hardware description languages (HDLs) such as Verilog and VHDL are fully
supported in both Lattice Diamond and the Radiant software. This section
describes various design HDL methodologies used in both Lattice Diamond
and the Radiant software, and highlights similarities and differences.

Using HDL in the Radiant Software

You can re-use your Verilog and VHDL source files when migrating designs
from Lattice Diamond to the Radiant software.
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Using Radiant Primitives

If your design contains Lattice Diamond primitives, you may need to replace
them with new Radiant primitives. For more information, refer to the FPGA
Libraries Reference Guide in the Radiant online Help.

Using Modules and Soft IP in the
Radiant Software

The IPexpress/Clarity tools in Lattice Diamond support two types of functional
blocks: modules and intellectual property (IP). In the Radiant software,
modules and IP can be created as part of a specific project or as a library for
multiple projects.

Modules are basic, configurable blocks that provide a variety of functions
including /O, arithmetic, memory, and more.

Soft IP are more complex, configurable blocks that must first be
downloaded and installed as a separate step before they can be
accessed.

The major difference between Lattice Diamond and the Radiant software is
the soft IP flow as shown in the following figures.

Figure 7: Lattice Diamond IPexpress/Clarity Flow
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Figure 8: Radiant Soft IP Flow
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The following table lists differences between the Lattice Diamond and the
Radiant soft IP and module flows.

Table 49: Diamond versus Radiant Soft IP and Module Flows

Lattice Diamond

A simulation testbench file is included

when IP is generated.

Uses Blowfish encryption.

Encrypted eRTL file used for

synthesis.

Obfuscated Verilog used for

simulation.

Many IP output files are generated.

Radiant Software

A simulation testbench file is included
when IP is generated. In module
generation, a simulation testbench file is
optional.

Uses IEEE 1735 encryption.

Encrypted modules/IP can be
synthesized and simulated.

Fewer IP output files are generated.
Flow simplified in the Radiant software.

Radiant IP Catalog Output Files for Modules |P Catalog generates the
output files shown in the following table for modules under the specified
Project Path. The <file_name> comes from the file name specified in the

Configuration tab.

Table 50: Radiant Module IP Output Files
File Type Definition

<file_name>.ipx IP manifest file

<file_name>.v Verilog module file

Function

Used to list all files generated by IP generation
engine.

Verilog netlist generated by IP Catalog to match the
configuration of the module.
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Table 50: Radiant Module IP Output Files (Continued)

File Type Definition Function

<file_name>_bb.v Verilog IP black box file Provides the Verilog synthesis black box for the IP
core and defines the port list.

<file_name>.cfg IP parameter configuration file Used for re-creating or modifying the core in IP
Catalog.

<file_name>.xml IP metadata file Describes the legal usage and interface of the soft IP.

<file_name>_tmpl.v Verilog template file Atemplate for instantiating the generated module.

This file can be copied into a Verilog file.

<file_name>_tmpl.vhd VHDL module template file A template for instantiating the generated module.
This file can be copied into a VHDL file.

Using Parameterized Module
Instantiation

Parameterized Module Instantiation (PMI) is an alternate way to use some of
the modules in Lattice Diamond and the Radiant software. PMI allows you to
directly instantiate a module into your HDL and customize it by setting
parameters in the HDL.

The following table lists the differences in Lattice Diamond PMI parameters
versus the Radiant PMI parameters.

Table 51: Lattice Diamond PMI Compared to the Radiant PMI

Category PMI Lattice Diamond Radiant Software

Architecture pmi_pll Yes No
pmi_pll_fp Yes No

Arithmetic pmi_add Yes Yes
pmi_addsub Yes Yes
pmi_complex_mult Yes Yes
pmi_constant_mult Yes No
pmi_counter Yes Yes
pmi_mac Yes Yes
pmi_mult Yes Yes
pmi_multaddsub Yes Yes
pmi_multaddsubsum Yes Yes
pmi_sub Yes Yes
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Table 51: Lattice Diamond PMI Compared to the Radiant PMI (Continued)

Category
DSP Arithmetic

FIFO

Distributed RAM

EBR

PMI

pmi_dsp
pmi_dsp_casmultaddsub
pmi_dsp_mac
pmi_dsp_mult
pmi_dsp_multaddsub
pmi_dsp_multaddsubsum
pmi_dsp_preadd_slice
pmi_fifo

pmi_fifo_dc
pmi_fifo_dp_be
pmi_fifo_dp_true_be
pmi_fifo_dq_be
pmi_distributed_dpram
pmi_distributed_rom
pmi_distributed_shift_reg
pmi_distributed_spram
pmi_ram_dp
pmi_ram_dp_be
pmi_ram_dp_true
pmi_ram_dp_true_be
pmi_ram_dq
pmi_ram_dq_be

pmi_rom

Lattice Diamond
No
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
No
No
No
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes
Yes

Yes

Radiant Software
Yes, iCE40 UltraPlus only
No
No
No
No
No
No
Yes
Yes
Yes
Yes
Yes
Yes
Yes
No
Yes
Yes
Yes
No
No
Yes
Yes

Yes

For more information on the Radiant soft IP and modules, refer to the

following documents:

Arithmetic Modules User Guide

Memory Modules User Guide

Design Implementation

This section describes how to import a Lattice Diamond project into the
Radiant software. This section also describes similarities and differences
between Lattice Diamond and the Radiant software.
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Lattice Diamond project files are not compatible with the Radiant project
files. Lattice Diamond project files use .Idf extension. The Radiant project
files use .rdf extension.

The Radiant software provides a wizard that allows you to import a Lattice
Diamond project into the Radiant software.

Importing a Lattice Diamond Project
into the Radiant Software

The Radiant software allows you to import Lattice Diamond projects using the
Import Diamond Project wizard. Many features and settings from Lattice
Diamond can be directly imported into the Radiant software, allowing you to
avoid creating a new project from scratch.

Starting the Import Diamond Project Wizard

Design projects created in Lattice Diamond can be imported into the Radiant
software using the Import Diamond Project wizard. Imported Lattice Diamond
projects are targeted to devices supported in the Radiant software. Lattice
Diamond design preferences will be converted into the Radiant software
design constraints.

To import a Lattice Diamond Project into Radiant software, open the Radiant
software. Then, choose File > Open > Import Diamond Project.

Figure 9: Import Diamond Project Wizard

,

Import Diamond Project

‘You are importing a Diamond project into Radiant. Since Radiant project file
is not compatible with Diamond project file, not all files can be imported.

Important Mote: Diamond project files and folders will not be impacted by
this import process. A new Radiant folder will be generated as your
spedified location.
For maore information, dick this link.
excellent value
for FPGA designs

To continue, dick Next.

Cancel
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For more information on using the Import Lattice Diamond Project wizard, in
the Radiant Help, see User Guides > Managing Projects > Importing
Lattice Diamond Projects.

Importing Lattice Diamond Strategies into the

Radiant Software

A strategy provides a unified view of all the options related to implementation
tools such as synthesis, map, and place and route. Strategy options are listed
in the Strategy dialog box in both Lattice Diamond and the Radiant software.

Lattice Diamond strategies are imported into the Radiant software if the
strategies are unchanged. If the Radiant software does not support Lattice
Diamond strategies, those Lattice Diamond strategies will be ignored. You
should check all strategies after they have been imported from Lattice
Diamond into the Radiant software.

Compatible Settings and Files

The following Lattice Diamond settings and source can be imported into the
Radiant software:

HDL Source Files and Properties HDL source files such Verilog (.v) and
VHDL (.vhd) can be imported into the Radiant software.

Synplify Pro SDC Files Synplify Pro Timing Constraint Files (SDC) can be
imported into the Radiant software.

Lattice Synthesis Engine Timing Constraint File LSE timing constraints
can be imported into the Radiant software. Some records with buses do not
use standard Tcl syntax and are discarded when loaded into the Radiant
database.

Implementations All implementations and their settings, such as top-level
unit and synthesis tool selection, are imported into the Radiant software.

Strategies All supported strategies are imported into the Radiant software.

Reveal Inserter Settings Reveal Inserter debug files (.rvl) are imported
from Lattice Diamond into the Radiant software. However, due to differences
between devices, not all options or features may be available in the Radiant
Reveal Inserter.

Simulation Wizard All Simulation Wizard scripts are imported into the
Radiant software.
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Incompatible Settings and Files

Some settings and files from Lattice Diamond are not compatible with the
Radiant software. The following Lattice Diamond settings and files cannot be
imported:

Target Device Currently no devices supported by Lattice Diamond are
supported in the Radiant software. Therefore, it will be necessary to select a
Radiant software-supported device.

Lattice Diamond Preference (.Ipf) Files Lattice Diamond preference files
(.Ipf) are not imported into the Radiant software. The Radiant software does
not support Lattice Diamond preferences. All Lattice Diamond preferences
must be manually converted into the Radiant software constraints.

Soft IP and Module (.ipx) Files Soft IP and Module package instance files
(.ipx and .sbx) are not imported because the IP flow in the Radiant software
differs from Lattice Diamond. Refer to “Using Modules and Soft IP in the
Radiant Software” on page 65 for a description of the differences.

Reveal Analyzer File Because of differences between devices, Lattice
Diamond Reveal Analyzer (.rva) files imported into the Radiant software may
not be useful. New waveforms generated with the Radiant Reveal Analyzer
will overwrite .rva files imported from Lattice Diamond.

Power Calculator File Because of differences between devices, Lattice
Diamond Power Calculator (.pcf) files cannot be imported into the Radiant
software.

Programmer Project File Because of differences between devices,
Programmer Project Files (.xcf) files cannot be imported into the Radiant
software.

Unsupported Design Source in Radiant
Software

The following design source files are not supported in the Radiant software
and cannot be imported:

EDIF Design Entry Files Electronic Design Interchange Format (EDIF) is
not supported in the Radiant software. Therefore, such files as .edf and .edn
cannot be imported into the Radiant software.

Schematic Files The Radiant software does not support schematic entry.
Therefore, schematic files cannot be imported into the Radiant software.

Clarity Design Files The Radiant software does not support Clarity
Designer (.sbx) files. Therefore, .sbx files cannot be imported into the Radiant
software.
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Platform Designer Files The Radiant software does not support Platform
Manager or Platform Manager 2 devices. Therefore, Platform Designer (.ptm)
files cannot be imported into the Radiant software.

Lattice Diamond and the Radiant
Process Flow

The Radiant graphical user interface has changed from the Lattice Diamond.
The Radiant main window is shown in Figure 10.

Processes are controlled using the Process Toolbar. All process tasks can be
viewed and selected using the Task Detail View.

The Radiant software also supports Lattice Diamond project features such

as Implementations and Strategies.

A major difference between Lattice Diamond and the Radiant software is
the constraint language and flow, as discussed in “Design
Implementation” on page 68.

Report View in the Radiant software is similar to Report View in Lattice
Diamond, but the Radiant software uses different report formats.

Figure 10: Radiant Software Main Window
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Design Analysis and Debug

Lattice Diamond

With the exception of the Simulation Wizard and Timing Analysis tools, the
debug and analysis tools within the Radiant software have remained
unchanged. For more information on Timing Analysis, refer to “Timing
Analysis” on page 76.

Simulation Wizard

The Simulation Wizard concept remains the same. You are guided through
the simulation set-up process as before.

The Radiant software now supports post-synthesis simulation. You are able to
perform a simulation of a post-synthesis netlist (<file_name>_syn.vo) file. In
order to generate this file, enable the Post-Synthesis Simulation File option in
Task Detail View and then synthesize the design.

Support for Post-Place and Route back-annotated simulation is consistent

with Lattice Diamond. The Post-Map back-annotated simulation is not
supported by the Radiant software.

Radiant Software

Process stage supported by Simulation Wizard: Process stage supported by Simulation Wizard:
RTL Simulation RTL Simulation
Post-Map Gate-Level Simulation Post-Synthesis Simulation
Post-Route Gate-Level + Timing Simulation Post-Route Gate-Level Simulation

Post-Route Gate-Level + Timing Simulation

First 22 ns of simulation is invalid.

Power Calculator

Power Calculator is unchanged from Lattice Diamond.

Reveal

The Reveal Inserter and Reveal Analyzer are the same as in Diamond but
with the addition of a Reveal Controller module. This new type of module
enables:

Access to the control and status registers of the hard IPs
Virtual switches and LEDs to control and monitor the design

Read and write access to a bank of user registers and memory
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Timing Analysis

The following table lists differences between Lattice Diamond and the Radiant

software.
Lattice Diamond Radiant Software
Timing is modeled as register-to-register within the FPGA  Timing is modeled register-to-register from outside of
boundary. Constraints are modeled in four methods: the FPGA boundary.
Input to output paths (MAXDELAY) Register to register paths (create_clock, set_input/

Input to register paths (INPUT_SETUP) output_delay, set_clack_latency)

Register to register paths (FREQUENCY/PERIOD)
Register to output paths (CLOCK_TO_OUT)

HTML links to timing paths. HTML-based table of contents for easy navigation.

Cross-probing from reports. You can click on a
hyperlink icon to cross probe into that tool. For
example, the Post-Synthesis & Map timing report
links to Netlist Analyzer. In the PAR timing report,
you can cross-probe to Netlist Analyzer, Floorplan
View, and Physical View.

Critical Endpoints: Critical paths listed for each single path Lists top critical endpoints irrespective of the constraint
analyzed. (Need to analyze every path to determine critical or path.
endpoints.)

Embedded within some of the timing reports. Unconstrained clocks and paths clearly listed.

Static Timing Analysis Concepts in Lattice
Diamond and the Radiant Software

Lattice Diamond modeled timing paths from within the FPGA boundary. This

explains why an assortment of timing preferences were available to model

timing paths that began and ended within the FPGA. Preference constraints

such as CLOCK _TO_OUT, INPUT_SETUP and MAXDELAY were used to
constrain these paths with the assumptions that any timing information for
arriving exterior logic is known.
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Figure 11: Lattice Diamond Constraint Timing Modeling

Circuit For Timing Analysis

MAXDELAY

'_~CLOCK_TO_OUT

FREQUENCY/PERIOD

Figure 11 shows an overview of how a circuit is modeled for timing within the
Radiant software. As mentioned earlier, the key difference with the Radiant
software is that the path is modeled from register-to-register across the entire
path which can begin and end outside of the FPGA boundary. As a result,
standard SDC constraints are used to model the input and output delays (that
is, set_input/output_delay) from external to the FPGA boundary, and
appropriate latency (Idc_set_latency) can be specified from external to
internal of the chip boundary.

Critical endpoints list the paths for clocking constraints that have no departure
or arrival element.

Unconstrained endpoints show paths that have no constraints defined even
though the path is clocked, indicating that there is no departure, arrival
primitive or port.

Figure 12: Sample Circuit Analysis

External Circuit Input Side Circuit For Timing Analysis External Circuit Output Side

+ 2 B W

set_input_delay| -"—L-/ - | b —> { set_output_delay

+ set_clock_latency T -+ |

CLK1 t5 CLK2 t& CLK3
create_clock
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For more information on Device Constraint Editor, refer to the Radiant Help
topic User Guides > Analyzing Static Timing > Using Timing Analysis
View > Timing Analysis View Feature > Timing Analysis View Main
Window Tabs.

Timing Analysis

The Radiant software makes it easier to analyze and navigate design
constraints. In addition to Preference Reports being replaced by .sdc
constraints, Timing Reports are now organized in a table of contents with
click-able .html links that take you to a specific section for analysis.

Once static timing analysis is performed, .twr and .html report files are
created. The report structure of the .sdc constraints is also different than in
Lattice Diamond.

The Radiant software Timing Report is grouped into multiple hyper-linked
categories, as shown below.

Figure 13: Radiant Software Timing Report

« Lists applied SDC timing constraints
+ Also checks combinational loops
1 DESIGN CHECKING
¢ 1.1 SDC Constraints + Clock implementation analysis
o 1.2 Combinatio v Single domain report
2 CLOCK SUMMA v" Clock domain crossing report
3 TIMING ANALYSIS SUMMARY
o 3.1 Overall (Setup and Hold)
o 3.2 Setup Summary Report
o 3.3 Hold Summary Report
o 3.4 Unconstrained Report
4 DETAILED REPORT
o 4.1 Setup Detailed Répart ;
o 4.2 Hold Detailed Report Statend peinis

+ TA summary information
v' Pass/fail result
v" Setup & hold summary tables
for constraints
v Also reports unconstrained

+ Reports detail timing analysis on
data and clock paths per constraint

Upon clicking a link, a comprehensive report is shown detailing all
calculations, as well as indicating whether a positive or negative slack has
occurred.

The Reports view also supports a path cross-probing through the timing or
analysis reports. You are able to view a specific clock or data path in Radiant
software tools such as Netlist Analyzer, Floor Planner, or Physical View by
clicking the icon next to the path. See Figure 14.
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Figure 14: Cross-Probing from a Timing Report
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A timing report consists of three primary sections:

Paths for Various Constraint - Setup and Hold constraints based on SDC
constraints applied.

Critical Endpoint Summary - Detailed path summary with total slack, delay
and clock information calculations based on endpoint element.

Unconstrained Endpoints summary - A calculation resulting from no paths
to an end point or because the end point was not properly constrained.

For more information on the details of Analyzing Static Timing, refer to the
Radiant Help topic User Guides > Analyze Static Timing > Running Timing
Analysis > Timing Analysis Report File > Timing Analysis Report.

Timing Analysis View

The redesigned Timing Analysis View features a detailed analysis of all
constraints, as shown in Figure 15. To view path, path detail, and path
calculations:

1. Click on a constraint in the Constraint box in the upper left.

2. Click on a path in the Path Summary box in the lower left.

The constraint’s path, path detail and path calculations are shown on the right.
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Figure 15: Timing Analysis View for the Radiant Software
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Figure 16 elaborates on Critical Endpoint Summary and Unconstrained
Endpoint Summary, the two primary types of Timing Analysis available, that

can assist you in debugging timing issues.
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Figure 16: Types of Timing Analysis
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The Timing Analysis View also provides the ability to search elements and
filter out specific paths for timing analysis. The following example shows how
to analyze a clock domain crossing from clk_1Hz to clk:

N o o M 0w N =

Set the source (clk_1Hz).

Select all Q pins.

Select all D pins.

Move selection to the “From box >".

Move selection to the “To box >".

Enter “/Q’ in the filter box to identify start points.

Enter “/D” in the filter box to get destination points.

All associated start and end points are listed in which a patch can be

selected fo

r analysis.

Path detail and calculation data are shown.

Apply the appropriate constraints for performance tuning.
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Radiant Software Tools

The Radiant software provides an improved user friendly, concise, and
efficient tool and design structure over its predecessor Lattice Diamond.

The following table lists the similarities and differences between Lattice
Diamond and the Radiant software tools.

Table 52: Tools Comparison Between Lattice Diamond and the Radiant

Software

Lattice Diamond Tools

Spreadsheet View
Package View
Device View
Netlist View

Netlist Analyzer

NCD View

IPexpress

Reveal Inserter and
Analyzer

Floorplan View

Radiant Software Tools

Device Constraint Editor (DCE):

Combines Spreadsheet, Package, Device and Netlist
views into one tool for the primary purpose of entering
physical (.pdc) constraints. This cross probing between
multiple views.

Some views in this tool can be hidden to maximize work
space.

For more information on Device Constraint Editor, see the
Radiant software online Help topic User Guides >
Applying Design Constraints > Using Radiant
Software Tools > Device Constraint Editor.

Netlist Analyzer:

Features are similar to Lattice Diamond.
Not supported.
IP Catalog:

Features are similar to Lattice Diamond, but with major
enhancements added, such as IEEE 1735 encryption
support for synthesis and simulation.

Reveal Inserter and Analyzer:

Features are similar to Lattice Diamond. The Power-On
Reset (POR) Debug feature is disabled. A new Reveal
Controller module enables access to a variety of registers
and memory.

For more information on the Reveal Controller Module,
see the Radiant online Help topic User Guides > Testing
and Debugging On-Chip.

Physical Designer: Placement Mode

Maijor features are similar to Lattice Diamond.
Enhancements include World View and IO Planner
features.
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Table 52: Tools Comparison Between Lattice Diamond and the Radiant
Software (Continued)

Lattice Diamond Tools Radiant Software Tools

Physical View Physical Designer: Routing Mode

Allows you to easily locate target objects using logic
hierarchy. Supports Netlist Widget, Property Widget, and
World View.

For IOLOGIC & /O pads, the ASIC View replaces Logic
Block View and Non-schematic table format.

The Radiant Physical Designer: Routing Mode supports
cross probing between Floorplan View and Physical View
and from DCE to Floorplan View.

The Radiant Physical Designer: Routing Mode also
supports one-way probing for ports.

The Radiant Physical Designer: Routing Mode does not
support switchbox and wire level display.

Timing Analysis View Timing Analysis View:

This tool has significant changes. For more information,
refer to “Timing Analysis View” on page 77.

Power Calculator, Power Calculator, integrated and stand-alone:

integrated Features are similar to Lattice Diamond, plus Power

Estimation mode in stand-alone.

Power Estimator, stand- Power Estimator, stand-alone:

alone . . .
Features are similar to Lattice Diamond.

Lattice Design Constraint Timing Constraint Editor:

(.LDC) Editor Pre-Synthesis Timing Constraint Editor tool used for

generating or editing pre-synthesis timing constraints
which are stored in .Idc file.

Post-Synthesis Timing Constraint Editor Tool used for

generating or editing post-synthesis timing constraints,
stored in .pdc file. These constraints may override the

pre-synthesis timing constraints.

For more information, see “Radiant Constraint Tools” on
page 54.

ECO Editor ECO Editor:

Features are similar to Lattice Diamond.

Programmer Programmer:
Features are similar to Lattice Diamond.

Includes Programmer, Deployment Tool, Download
Debugger, and Programming File Utility.

Model 300 Programmer is not supported.

Partition Manager Not supported.
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Table 52: Tools Comparison Between Lattice Diamond and the Radiant

Software (Continued)

Lattice Diamond Tools

Synplify Pro for Lattice

Active-HDL Lattice
Edition

Run Manager

Simulation Wizard

Radiant Software Tools

Synplify Pro for Lattice:

Features are similar to Lattice Diamond. For more
information on Synplify Pro for Lattice, from the Radiant
software start page, click:

User Guides > Synopsys Synplify Pro for Lattice User
Guide and

User Guides > Synopsys Synplify Pro for Lattice
Reference Manual.

Active-HDL Lattice Edition (Windows only):

Features are similar to Lattice Diamond. For more
information about Active-HDL Lattice Edition, from the
Radiant software start page, click:

User Guides > Active-HDL On-line Documentation
(Windows only).

Run Manager:

Features are similar to Lattice Diamond.

Simulation Wizard:
Features are similar to Lattice Diamond.

Post-Synthesis simulation is supported.
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Revision History

The following table gives the revision history for this document.

Date Version Description

02/18/2021 2.2.1

06/08/2020 2.1

11/21/2019 2.0

03/25/2019 1.1
02/12/2018 1.0

Added new content to include the GSR primitive usage
changes.

Added support for Radiant 2.1 software.

Updates to:

“Changes to Arithmetic PMI for CrossLink-NX vs ECP5”
on page 40.

“Changes to Memory PMI for CrossLink-NX vs ECP5” on
page 43.

Added migrating ECP5 and CrossLink designs to
CrossLink-NX.

Added support for Radiant 1.1 software.

Initial Release.
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